
GRANDMASTER SUITE

User’s Guide to Administration



Information in this document is subject to change without notice and does not represent a commitment

on the part of Can-Pay. The software described in this document is furnished under a license agreement.

The software may be used or copied only in accordance with the terms of the agreement. No part of this

manual may be reproduced or transmitted in any form or by any means, electronic or manual, including

photocopying and recording, for any purpose other than the purchaser's personal use without the written

permission of Can-Pay Computer Software Ltd.

ACCPAC is a registered trademark of Computer Associates International, Inc.
Btrieve is a registered trademark of SoftCraft, Inc.
Client Strategist is a registered trademark of MICROWARE Consultants Inc.
MS-DOS and Windows are registered trademarks of Microsoft Corporation.
Epson is a registered trademark of Epson America, Inc.
GrandMaster II is a registered trademark of Can-Pay Computer Software Ltd.
Great Plains Software and Great Plains Logo are registered trademarks of Great Plains Software Inc.
IBM and OS/2 are registered trademarks of International Business Machines Corp.
Macola is a registered trademark of Macola, Inc.
Okidata is a registered trademark of Oki America, Inc.
Platinum is a registered trademark of Advanced Business Microsystems, Inc.
Qume is a registered trademark of Qume Corporation.
Micro Focus is a registered trademark of Micro Focus Limited.

Printed in Canada –08/98

Can-Pay Computer Software



Table of Contents

INTRODUCTION 1

Welcome . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Software License Agreement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Acquiring Technical Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Update Service Agreement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Registration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

System Requirements · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 5

Year 2000 Compliant · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 5

Manual Conventions · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 6

Visual Cues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Manual Text Styles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Keyboard Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

INSTALLATION 7

Installing GrandMaster Suite · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 7

Windows 95/NT Installation - CD ROM · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 8

Windows 95/NT Installation - (32 Bit) Nine Diskettes . . . . . . . . . . . . . . . . . . . . . . 12

Installation - License Windows 95 and Windows NT . . . . . . . . . . . . . . . . . . . . . . . 17

Windows 3.1 (16 Bit) Installation CD-Rom. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Windows 3.1 (16 Bit) Installation - Six Diskettes . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Installation-License-Windows 3.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

OS/2 Installation- CDROM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Can-Pay Computer Software i

Table of Contents - ii

T
A

B
LE

O
F

C
O

N
T

E
N

T
S



OS/2 Installation - Six Diskettes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Installation - License - OS/2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Other Installation Considerations · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 42

Installation of Software Updates· · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 42

AUTOEXEC.BAT Commands · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 43

Special Note for Windows 95 and Windows NT Install. . . . . . . . . . . . . . . . . . . . . . 44

Installation of 32 bit Software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Problem Resolution. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

DOS and Network File Resources · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 46

Windows 3.1 and Windows 95/NT· · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 46

Peer to Peer Network Setup - Windows 95 and Windows NT· · · · · · · · · · · · · · · · · 47

Prime Workstation where GrandMaster Suite will be resident . . . . . . . . . . . . . . . . 47

Other Workstations that will access GrandMaster Suite . . . . . . . . . . . . . . . . . . . . . 48

GrandMaster Suite Windows and GM II · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 49

GM II Setup Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

On-Line Documentation · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 51

Obtaining Software Updates · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 51

Problems locating the license file · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 52

THE BASICS 53

System Startup Processing · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 53

The Basic Elements of the GrandMaster System Manager · · · · · · · · · · · · · · · · · · · 54

The Logon. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

The Main Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

ii Can-Pay Computer Software

ii - Table of Contents



Main Screen Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

The Menu System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Dialog Boxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Selection Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

The On-Line Help System · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 60

HELP Main Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Help Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Context-sensitive Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Printer Setup · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 62

Printer Support · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 63

Backing Up Your Files · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 64

CONVERSION 65

Payroll Conversion - GrandMaster II · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 66

Conversion Procedure Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

Set the GM II file location . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Creating the Suite payroll . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Select and convert the payrolls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Conversion Process· · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 74

Confirm the conversion processing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Payroll Conversion - GrandMaster I· · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 76

Conversion Procedure Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Run the GM2PREP Program . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Creating the Suite payroll . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

Can-Pay Computer Software iii

Table of Contents - ii

T
A

B
LE

O
F

C
O

N
T

E
N

T
S



Select and convert the payrolls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

Conversion Process. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

Confirm the conversion processing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

Convert Homecare Clients · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 86

New Customers of GrandMaster Suite Payroll· · · · · · · · · · · · · · · · · · · · · · · · · · · · · 88

MANAGING ADMINISTRATION 91

Main Administration Module · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 92

Update User ID's · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 94

Setting a Password . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

Restricting Access. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Global Preferences · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 110

General Ledger Definition · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 112

Initialization Parameters · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 114

UTILITIES 117

Start Utility Program· · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 118

Utility Programs · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 119

APPENDIX I

File System Errors· · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · I

Error Codes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . II

OVERVIEW · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · VI

Indexed File Reorganization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . VI

Recovery of Corrupt Indexed Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . VI

iv Can-Pay Computer Software

ii - Table of Contents



Rebuild file Index Utility · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · VII

OPERATION · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · VIII

Rebuild Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . IX

Examples of Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . XV

Parameter Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . XVI

Redirection of Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . XVII

General Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . XVIII

SYSTEM PARAMETERS · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · XVIII

ERROR, INFORMATION AND WARNING MESSAGES · · · · · · · · · · · · · · · · · XIX

Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . XIX

Command Line Errors: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . XIX

Rebuild Errors: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . XXIII

Information Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . XXVI

Warning Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . XXVI

Can-Pay Computer Software v

Table of Contents - ii

T
A

B
LE

O
F

C
O

N
T

E
N

T
S



.



INTRODUCTION

Welcome

Welcome to Can-Pay's GrandMaster Suite of Applications. A fully integrated
Windows orOS/2 group of products developed inCanada forCanadian requirements.
Can-Pay, specializing in Canadian payroll and payroll related software since 1985,
has developed this unique suite of software. CanPay's previous products, the
GrandMaster and GrandMaster II payroll system has become well renowned for
handling complex Canadian payroll situations.
The integration of Human Resource, Scheduling, Time Keeping, and Resource
Planning modules with Can-Pay's vast payroll experience provide a strong, fully
integrated product to fulfill all of your payroll/personnel requirements.
The features of the suite include:

1. Administration module - controls the use and access to other modules within
the group.

2. Payroll - provides the most advanced payroll system available in the personal
computer market place.

3. Human Resources - provides direct access to information from payroll
calculations, scheduling, time keeping, and organization charts to provide an
effective personnel management tool.

4. Scheduling - allows for the creation of work schedules with rotation patterns.

5. Time Keeping - introduces work rules to scheduling modules and allows for
data entry of hours or direct import from electronic time clocks.

6. Resource Planning - allows you to develop an employment needs structure to
be fulfilled by the scheduling module.

7. Electronic Funds Transfer - organized payroll cheque information for
transmission to any Canadian bank.

8. Labour Distribution - gives the capability of providing labour analysis by a
variety of classification break downs.

Can-Pay is committed to customer satisfaction by specializing in satisfying payroll
needs. We possess an extensive expertise of payroll requirements and make
responding to customer needs our priority.
We hope you enjoy the GrandMaster Suite, and we hope to maintain a long-lasting
relationship!
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Software License Agreement

Can-Pay provides this Programand aLicense for its use to the original Purchaser. This
program is protected by copyright laws and the Purchaser agrees to abide by these
regulations. The programmay consist of one ormoremodules, each designed towork
as a group to achieve a desired result. This license agreement covers allmodules of the
GrandMaster Suite. The modules can consist of the following:

Administration Labour Distribution Resource Planning

Payroll Time Keeping Homecare

Human Resources Electronic Funds Transfer Option Applications

Schedule Bank Reconciliation

The Purchaser remains solely responsible for selecting the Program to achieve the
intended results, and for the installation and use of the Program.
The License entitles the Purchaser to:

n Install the Program on a single machine which may be a computer local area
network, inwhich case,multi-usersmay access the single copy of the Program.

n Make copies of the Program for backup.

n Apply for Update Service for which the Purchaser will pay an annual fee.
Can-Pay will revise or update the Program as required.

Program

Limitation:

The use of the Program is limited to 20 employees unless the Purchaser has obtained a
License Program from Can-Pay to expand the limitation. The License Program will
have an expiry date at which time the expanded limitation will revert back to 20
employees.

Terms: The license is in effect until terminated or until the Purchaser terminates the license by
failing to pay theAnnual Service feewithin 30 days of receipt of invoice. The License
may be terminated at any time by returning the Program togetherwith the backup copy
and all documentation to Can-Pay.

Confidentiality: The Purchaser acknowledges that the Program is confidential in nature and of great
value and agrees to take reasonable precautions to keep the Program confidential.

Limited

Warranty:

Can-Pay limits its warranty to the replacement of defective diskette(s) on which the
Program is recorded. Can-Paymakes no otherwarranties, either expressed or implied.
Can-Pay reserves the right to change the characteristics of the Programover a period of
time, without notice to the Purchaser.

Liability: Can-Pay shall not be liable for the inability of the Program to perform a function or the
accuracy of the results, nor for indirect, special or consequential damage such as loss
of profits or inability to use the Program.

2 Can-Pay Computer Software
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Acquiring Technical Support

The License Program contains the full name and address of the license holder and a
product serial number. You will be requested to provide this serial number when
calling for technical support.
YouMUST retain your license diskette for later use as some updates may require that
you re-install the license after a software update.
Please see the Installation Chapter, for information about how to install the
GrandMaster Suite license.

Update Service Agreement

The Update Service Agreement entitles the registered user of GrandMaster Suite to
receive regular updates to the programs. Can-Pay agrees to monitor changes in
provincial and federal regulations and further agrees to keep abreast of user
requirements and changing trends in payroll. When deemed necessary or advisable by
Can-Pay, the Program will be updated to current specifications and new program
diskettes will be promptly forwarded to each registered user.
In order to receive the update service, the original purchaser must complete the
attachedUpdate ServiceCard and forward it toCan-Pay, alongwith proof of purchase,
within 30 days of purchase. The first year of service is included in the purchase price,
after which the user will be invoiced annually on the purchase anniversary date.
Can-Pay reserves the right to change the cost of this service without notice.
Upon receipt of the Update Service Card, Can-Pay will ensure the user's software
complies with current government regulations and will continue to provide updates
while this agreement is in force.

Can-Pay Computer Software 3
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Registration

It is important to you to fill out and send in your registration card as soon as possible.
Please include the update service card, and proof of purchase within 30 days of
purchase. Please advise us at the same time of the preferred method of update service,
either by diskettes or CDROM. It is also important to advise us of your current
operating system in order for us to send the correct update format. Registration entitles
you to:

n 1 year of update service and technical assistance to applicable modules.

n eligibility for furtherupgrades, aswarranted by user requirements and changes
in provincial and federal regulations

n assurance that the version of software you purchase meets current statutory
requirements.
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System Requirements

The GrandMaster Suite of programs is designed to run on a Personal Computer with
the following attributes:

n CPU�486or higher forWindows 3.1 andOS/2Pentium forWindows 95/NT

n RAM (memory) � minimum 8 megabytes for Windows 3.1; 32 megabytes for
Windows 95; 64Megabytes forWindowsNTand 16megabytes forOS/2Warp
version 4 or better. These are recommended minimums.

n Hard Drive � at least 30 MB free for program files, 100 MB free for data files,
using as an example the approximate data space required per year for a 200
person payroll.

n Display � colour SVGA 800 x 600 recommended

n Operating System �Windows 3.x, Windows 95 or OS/2Warp 4.x or Windows
NT

n Network - Novell, OS/2 Warp Server, Windows, NT

n Back Up - Third party facility with sufficient capacity to back up system

data files.

Year 2000 Compliant

The GrandMaster Suite of programs was designed to work for you for many years to
come including the transition through the turn of the century.
The GrandMaster Suite of programs is Year 2000 compliant and will continue to
operate correctly. However, it is dependent on the environment where it is installed.
You should ensure that your hardware and operating system are also Year 2000
compliant.
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Manual Conventions

To help the user locate and interpret information easily, this manual employs
consistent visual cues and text formats. These conventions are as follows:

Visual Cues

Examples are shown within lines as follows:

Example: This is a sample “example box”.

F Notes are indicated with a hand symbol.

N Warnings are indicated with a �skull-and-crossbones�.

Manual Text Styles

Lead-in Text This provides quick, easy access to information throughout the manual.

Text Formats ALL CAPITALS are used to refer to directory names and filenames.

Example: The hard drive location C:\GMSUITE

Capitalized Bold is used to represent menu options.

Example: Select theAdd Payroll option from the File menu.
(means to open the “File” menu and select the option called “Add
Payroll”)

SMALL CAPITALS are reserved for names of keys on the keyboard and buttons on the
screen.

Example: pressALT

(means press the “ALT” key on the keyboard)

Keyboard Operations

KEY1 + KEY2 The plus sign (+) indicates thatKEY1 is to be held down while
you pressKEY2.

KEY1, KEY2 The comma (,) indicates thatKEY1 is to be pressed and
released, followed byKEY2 being pressed and released.
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INSTALLATION

Installing GrandMaster Suite

This sectionwill describe the steps necessary to install the GrandMaster Suite. Before
attempting an installation, please check the system requirements in the Introduction
Section of this manual for the minimum system configuration.

TheGrandMaster Suite of programs is distributed as a set of diskettes or as aCDROM.
The GrandMaster Suite of programs is also available to be downloaded from our
website.

There are several installation procedures outlined in the following pages. Select the
appropriate method for your requirements. Before proceeding with the installation
please also review carefully the section of the chapter entitled �Other Installation
Considerations� GrandMaster Suite - Contents of CD-ROM.

This CD-ROM contains the distribution kits for all operating systems supported for
GrandMaster Suite. The CD-ROM also contains the documentation for GrandMaster
Suite in Adobe Acrobat format (PDF Files) and the installation programs for Acrobat
Reader V3.0 for Windows 3.1, Windows 95/NT and OS/2.

You install the GrandMaster Suite of programs by running the. Install programs from
the directory that is appropriate to your operating system. The installation program
will automatically determine if the program was previously installed and will update
the previous installation.

The directories present on the CD-ROM are:

\Windows GrandMaster Suite for Windows (16 Bit)
\OS/2 GrandMaster Suite for OS/2
\Windows 95NT GrandMaster Suite for Windows (32 Bit)
\Acrobat Acrobat Reader for Windows and OS/ 2
\DOC GrandMaster Suite Documentation in PDF Format

The root directory of the CD-ROM contains a readme file detailing the contents of the
CD-ROMand the RELNOTES.TXT file. TheRELNOTES.TXT file contains a list of
the changes and corrections to the GrandMaster Suite Software.
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Windows 95/NT Installation - CD ROM

1. Insert CD-ROM into CD Drive

2. The Installation program is automatically started when this CD-ROM is
inserted into a Windows 95 or Windows NT CD-ROM Drive that has Auto
Run enabled.

Or

3. If AutoRun is not enabled, go to �My Computer� and open CD-ROM icon.
Double click on the WIN95NT folder. The software is installed for Windows
95 and Windows NT by executing the INSTLALL.EXE program in the
\Win95NT directory.

4. When the necessary files have been loaded the following screen will appear:
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5. Press the continue button to proceed with installing GrandMaster Suite or
select the Exit button if you wish to stop the process. Continuing with the
installation calls up a dialog box which displays the product and version
numbers.

6. Select the OK button to continue. A dialog box will appear as follows:
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7. Select the components to be installed and verify the location for the directories.
There are 12 sub-directories of the GrandMaster Suite directory that will be
created during the installation.

Directory Description

\GMSUITE Root directory for the software. This directory normally

contains the GRAND.INI file for the software.

\GMSUITE\ADMIN Directory containing the system administration data files.

\GMSUITE\COMMON Directory containing the common data files.

\GMSUITE\PAYROLL Directory containing the payroll base data files.

\GMSUITE\HR Directory containing the human resources data files.

\GMSUITE\SCHEDULE Directory containing the scheduling data files.

\GMSUITE\TIMEKEEP Directory containing the time keeping data files.

\GMSUITE\ORGCHART Directory containing the resource planning data files.

\GMSUITE\EFT Directory containing the electronic funds transfer data files.

\GMSUITE\JOBCOST Directory containing the labour distribution data files.

\GMSUITE\BANKREC Directory containing the bank reconciliation data files.

\GMSUITE\RUNTIME Directory containing the executable programs for GrandMaster

Suite.

The directories shown above are created during the installation. Values are stored in
the initialization parameters file �GRAND.INI�.
The systemadministrator should be consulted prior to altering this directory structure.

N If the initialization parameters file is changed, the user is responsible for moving any
data files to the new directories. The system will create new empty directories if they
are not available on the startup.

Press the Select ALL button or, if the GrandMaster Suite is to reside as a sub directory
under another directory, insert a drive letter and major directory name in from of each
of 12 GMSUITE directories.

EXAMPLE:

W:\APPS\PAYROLL\GMSUITE
W:\APPS\PAYROLL\GMSUITE\ADMIN

To re-direct the location from the local default Drive C:, Select �Disk Space� button.
A drop down list of available drives and space accessible from this computer will
appear. Highlight the desired drive locations and tick the box to �Changes All
Directories�. Click �OK�.
Once you have ensured that the GrandMaster Suite of all programs will be directed to
the correct drive, you may proceed with the installation by pressing the �Install�
button.
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8. The Installation will proceed and the following screen will appear showing the
progress.

On average, a CD-ROM install takes between one and two minutes.

9. Once the installation in complete, a message screen will appear advising you
that the GrandMaster Suite installed successfully and that the CONFIG.SYS
file has been altered to now include GrandMaster Suite. The message also
advises you to shut down and re start your system to activate the changes.
Select �OK�.

10.Select Exit from GrandMaster Suite Installation program.

11.Remove CD-ROM from CD-ROM drive and proceed with �Shut Down�.
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Windows 95/NT Installation - (32 Bit) Nine Diskettes

In the event that you do not have an operating CD-ROM drive, you may request a
GrandMaster Suite Windows 95/NT (32 Bit) distribution kit. This distribution kit
consists of 9 diskettes for the program installation.

1. Insert Disk 1 into Diskette Drive

2. Under �My Computer� select Drive A to open. Double click on the
INSTALL.EXE folder.
OR

3. Under �Start�, �Programs� go to MSDOS Prompt.

n CD\ [ENTER]
Type A: Install [ENTER]

4. When the necessary files have been loaded the following screen will appear:
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5. Press the Continue button to proceed with installing Grandmaster Suite or
select �Exit� button if you wish to stop the process. Continuing with the
installation calls up a dialog box which displays the product and version
number.

6. Select the OK button to continue. A dialog box will appear as follows:
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7. Select the components to be installed and verify the location for the directories.
There are 12 sub-directories of the GrandMaster Suite directory that will be
created during the installation.

Directory Description

\GMSUITE Root directory for the software. This directory normally

contains the GRAND.INI file for the software.

\GMSUITE\ADMIN Directory containing the system administration data files.

\GMSUITE\COMMON Directory containing the common data files.

\GMSUITE\PAYROLL Directory containing the payroll base data files.

\GMSUITE\HR Directory containing the human resources data files.

\GMSUITE\SCHEDULE Directory containing the scheduling data files.

\GMSUITE\TIMEKEEP Directory containing the time keeping data files.

\GMSUITE\ORGCHART Directory containing the resource planning data files.

\GMSUITE\EFT Directory containing the electronic funds transfer data files.

\GMSUITE\JOBCOST Directory containing the labour distribution data files.

\GMSUITE\BANKREC Directory containing the bank reconciliation data files.

\GMSUITE\RUNTIME Directory containing the executable programs for GrandMaster

Suite.

The directories shown above are created during the installation. Values are stored in
the initialization parameters file �GRAND.INI�.
The systemadministrator should be consulted prior to altering this directory structure.

N If the initialization parameters file is changed, the user is responsible for moving any
data files to the new directories. The system will create new empty directories if they
are not available on the startup.

Press the Select ALL button or, if the GrandMaster Suite is to reside as a sub directory
under another directory, insert a drive letter and major directory name in from of each
of 12 GMSUITE directories.

EXAMPLE:

W:\APPS\PAYROLL\GMSUITE
W:\APPS\PAYROLL\GMSUITE\ADMIN

To re-direct the location from the local default Drive C:, Select �Disk Space� button.
A drop down list of available drives and space accessible from this computer will
appear. Highlight the desired drive location and tick the box to �Changes All
Directories�. Click �OK�.
Once you have ensured that the GrandMaster Suite of all programs will be directed to
the correct drive, you may proceed with the installation by pressing the� Install�
button.
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8. The installation will proceed and the following screen will appear showing the
progress.

9. Once Disk 1 has been loaded, a prompt will appear to Insert disk 2.
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10.Place Disk 2 into the Diskette drive and select the Continue button. This
process will be repeated for the remaining diskettes. Once all nine diskettes
have been installed a message screen will appear advising you that the
GrandMaster Suite installed successfully and that the CONFIG.SYS file has
been altered to now include GrandMaster Suite. The message also advises you
to shut down and re start your system to activate the changes. Select �OK�.

11.Select �Exit� from GrandMaster Suite installation program.

12.Remove the last diskette from the drive and proceed with �Shut Down�.
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Installation - License Windows 95 and Windows NT

The GrandMaster Suite of Programs must be installed before installing your license
disk. Your license will not be included on the CD-ROM but will be distributed by
diskette for the foreseeable future.
It is important to request and install your license disk if you wish to implement the
system for more than 20 employees. Without a license disk installed, GrandMaster
Suite is considered a �Demo - For Evaluation� only.

1. The GrandMaster Suite License disk should be inserted into the diskette drive.

2. Under �My Computer� icon select Drive A. The contents of Drive A will be
read and a Window will be presented on the screen listing the files on the disk.
Double click on the INSTALL.Exe folder.
OR

3. Under �Start�, �Programs�, go to MSDOS Prompt.
Do CD\ to change directories and type A: Install [ENTER]

4. A window will appear indicating that the GrandMaster Suite License
installation program is loading files.

After the loading of the files is completed, the following dialog box will appear which
allows the user to continue with the installation,or Exit (Cancel) from the install
process.
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5. Press the continue button to proceed with the installation. The following
screen will appear asking if you wish to install this product.

6. Press �OK� to Install the License.

7. Select the components to be installed and verify the location for the directories.
There are two directories that will be affected during the license installation.

Press the �Select All� button or insert major directory name and location in front of
each of two GMSUITE directories.
To re-direct the drive location from the local default Drive C: Select �Disk Space�
button. A drop down list of available drives and space accessible from this computer
will appear. Highlight the desired drive location where GrandMaster Suite programs
were previously installed and tick the box to �Change all Directories�. �Click OK�.

F Ensure that the license disk is installed to the correct drive where GrandMaster Suite
has been installed previously.
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8. Select the Install button to install the license.

9. Once the license installation has been completed, a message screen will appear
advising you that the GrandMaster Suite license installed successfully. The
message also advises you to shut down and re-start your system, however, a
full shut-down is not necessary at this stage.

10.Select Exit and return to your desktop.

11.Remove the disk from the diskette drive and store it in a safe place.
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Windows 3.1 (16 Bit) Installation CD-Rom

1. Insert CD-ROM into CD-ROM drive

2. Under File Manager go to �Run� command. On the command line prompt
type the drive letter of CD-ROM drive (?)\WINDOWS\INSTALL.EXE
[ENTER]

3. When the necessary files have been loaded, the following screen will appear:

4. Press the Continue button to proceed with installing GrandMaster Suite or
select the Exit button if you wish to discontinue the installation. Continuing
with the installation calls up a dialog box which displays the product and
version numbers.
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5. Select the OK Button to continue. A dialog box will appear as follows:

6. Select the components to be installed and verify the location for the directories.
There are 12 sub-directories of the GrandMaster Suite directory that will be
created during the installation.

Directory Description

\GMSUITE Root directory for the software. This directory normally

contains the GRAND.INI file for the software.

\GMSUITE\ADMIN Directory containing the system administration data files.

\GMSUITE\COMMON Directory containing the common data files.

\GMSUITE\PAYROLL Directory containing the payroll base data files.

\GMSUITE\HR Directory containing the human resources data files.

\GMSUITE\SCHEDULE Directory containing the scheduling data files.

\GMSUITE\TIMEKEEP Directory containing the time keeping data files.

\GMSUITE\ORGCHART Directory containing the resource planning data files.

\GMSUITE\EFT Directory containing the electronic funds transfer data files.

\GMSUITE\JOBCOST Directory containing the labour distribution data files.

\GMSUITE\BANKREC Directory containing the bank reconciliation data files.

\GMSUITE\RUNTIME Directory containing the executable programs for GrandMaster

Suite.

The directories shown above are created during the installation. Values are stored in
the initialization parameters file �GRAND.INI�.
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The systemadministrator should be consulted prior to altering this directory structure.

N If the initialization parameters file is changed, the user is responsible for moving any
data files to the new directories. The system will create new empty directories if they
are not available on the startup.

Press the Select ALL button or, if the GrandMaster Suite is to reside as a sub directory
under another directory, insert a drive letter and major directory name in front of each
of 12 GMSUITE directories.

EXAMPLE:

W:\APPS\PAYROLL\GMSUITE
W:\APPS\PAYROLL\GMSUITE\COMMON

To re-direct the location from the local default Drive C:, Select �Disk Space� button.
A drop down list of available drives and space accessible from this computer will
appear. Highlight the desired drive locations and tick the box to �Changes All
Directories�. Click �OK�.
Once you have ensured that the GrandMaster Suite of all programs will be directed to
the correct drive, youmayproceedwith the installation by pressing the Install button.
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7. The installation will proceed and the following screen will appear showing the
progress:

8. Once the installation is complete, a message screen will appear advising you
that the GrandMaster Suite installed successfully and that the CONFIG.SYS
file has been altered to now include GrandMaster Suite. The message also
advises you to shut down and restart your system to activate the changes.
Select �OK�.

9. Select Exit from GrandMaster Suite Installation program.

10.Remove CD-ROM from CD-ROM drive and proceed with �Shut Down�.
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Windows 3.1 (16 Bit) Installation - Six Diskettes

In the event that you do not have an operating CD-ROM drive, you may request a
GrandMaster SuiteWindows (16 Bit) distribution kit. This distribution kit consists of
6 diskettes for the program installation.

1. Insert Disk 1 into the diskette drive.

2. Under File Manger go to �Run� command. On the command line prompt type
A: Install [ENTER]

3. When the necessary files have been loaded the following screen will appear:

4. Press the continue button to proceed with installing GrandMaster Suite or
select the Cancel button if you wish to discontinue the installation. Proceeding
with the installation calls up a dialog box which displays the product and
version numbers.
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5. Select the OK button to continue. A dialog box will appear as follows:

6. Select the components to be installed and verify the location for the directories.
There are 12 sub-directories of the GrandMaster Suite directory that will be
created during the installation.

Directory Description

\GMSUITE Root directory for the software. This directory normally

contains the GRAND.INI file for the software.

\GMSUITE\ADMIN Directory containing the system administration data files.

\GMSUITE\COMMON Directory containing the common data files.

\GMSUITE\PAYROLL Directory containing the payroll base data files.

\GMSUITE\HR Directory containing the human resources data files.

\GMSUITE\SCHEDULE Directory containing the scheduling data files.

\GMSUITE\TIMEKEEP Directory containing the time keeping data files.

\GMSUITE\ORGCHART Directory containing the resource planning data files.

\GMSUITE\EFT Directory containing the electronic funds transfer data files.

\GMSUITE\JOBCOST Directory containing the labour distribution data files.

\GMSUITE\BANKREC Directory containing the bank reconciliation data files.

\GMSUITE\RUNTIME Directory containing the executable programs for GrandMaster

Suite.

The directories shown above are created during the installation. Values are stored in
the initialization parameters file �GRAND.INI�.
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The systemadministrator should be consulted prior to altering this directory structure.

N If the initialization parameters file is changed, the user is responsible for moving any
data files to the new directories. The system will create new empty directories if they
are not available on the startup.

Press the Select ALL button or, if the GrandMaster Suite is to reside as a sub directory
under another directory, insert a drive letter and major directory name in front of each
of 12 GMSUITE directories.

EXAMPLE:

W:\APPS\PAYROLL\GMSUITE
W:\APPS\PAYROLL\GMSUITE\ADMIN

To re-direct the drive location from the local default Drive C:, Select �Disk Space�
button. A drop down list of available drives and space accessible from this computer
will appear. Highlight the desired drive locations and tick the box to �Changes All
Directories�. Click �OK�.
Once you have ensured that the GrandMaster Suite of all programs will be directed to
the correct drive, youmayproceedwith the installation by pressing the Install button.

7. The installation will proceed and the following screen will appear showing the
progress.
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8. Once Disk 1 has been loaded, a prompt will appear to insert disk 2.

9. Place disk 2 into the diskette drive and select the �Continue� button. This
process will be repeated for the remaining diskettes. Once all six diskettes
have been installed, a message will appear advising you that the GrandMaster
Suite was installed successfully and that the CONFIG.SYS file has been
altered to now include GrandMaster Suite. The message also advises you to
shut down and restart your system to activate the changes. Select �OK�

10.Select �Exit� from GrandMaster Suite Installation program.

11.Remove last diskette from drive and proceed with �Shut Down�.
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Installation-License-Windows 3.1

The GrandMaster Suite of programs must be installed before installing your license
disk.
Your License will not be included on the CD-ROM but will be distributed by diskette
for the foreseeable future.
It is important to request and install your license disk if you wish to implement the
system formore than 20 employees. Without a license installed, GrandMaster Suite is
considered a �Demo - For Evaluation� only.

1. Insert the license disk into the diskette drive.

2. Under File Manager, go to�RUN� command. On the command line prompt
type A: Install [Enter]

3. A window will appear indicating that the GrandMaster Suite License
installation program is loading files.

After the loading of the files is completed, the following dialog box will appear which
allows the user to continue with the installation, or Exit (Cancel) from the install
process.
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4. Press the �Continue� button to proceed with the installation. The following
screen will appear asking if you wish to install this product.

5. Press �OK� to install the license.

6. Select the components to be installed and verify the location for the directories
that will be affected during the license installation.

Press the �Select All� Button or insert major directory name and location in front of
each of two GMSuite directories.
To re-direct the drive location from the local default drive C:; Select �Disk Space�
button. A drop down list of available drives and space accessible from this computer
will appear. Highlight the desired drive location where GrandMaster Suite programs
were previously installed and tick the box to �Change All Directories. �Click OK�.

F Ensure that the License disk is installed to the correct drive where GrandMaster Suite
had been installed previously.

7. Select the Install button to install the license.

8. Once the License installation has been completed, a message screen will
appear advising you that the GrandMaster suite License installed successfully.
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The message also advises you to shut down and re-start your system,
however,a full shut down is not necessary at this stage.

9. Select Exit and return to your desktop.

10.Remove disk from diskette drive and store in a safe place.
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OS/2 Installation- CDROM

1. Insert CD-ROM into CD-ROM drive.

2. Under Drives Icon, go to CD Drive and double click to open Drive, open the
OS/2 folder and double click on the INSTALL.EXE program.

3. When the necessary files have been loaded the following screen will appear:

4. Press the continue button to proceed with installing GrandMaster Suite or
select the cancel button if you wish to discontinue the installation. Continuing
with the installation calls up a dialog box which displays the product and
version numbers.
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5. Select the OK button to continue. A dialog box will appear as follows:

6. Select the components to be installed and verify the location for the directories.
There are 12 sub-directories of the GrandMaster Suite directory that will be
created during the installation.

Directory Description

\GMSUITE Root directory for the software. This directory normally

contains the GRAND.INI file for the software.

\GMSUITE\ADMIN Directory containing the system administration data files.

\GMSUITE\COMMON Directory containing the common data files.

\GMSUITE\PAYROLL Directory containing the payroll base data files.

\GMSUITE\HR Directory containing the human resources data files.

\GMSUITE\SCHEDULE Directory containing the scheduling data files.

\GMSUITE\TIMEKEEP Directory containing the time keeping data files.

\GMSUITE\ORGCHART Directory containing the resource planning data files.

\GMSUITE\EFT Directory containing the electronic funds transfer data files.

\GMSUITE\JOBCOST Directory containing the labour distribution data files.

\GMSUITE\BANKREC Directory containing the bank reconciliation data files.

\GMSUITE\RUNTIME Directory containing the executable programs for GrandMaster

Suite.

The directories shown above are created during the installation. Values are stored in
the initialization parameters file �GRAND.INI�.
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The systemadministrator should be consulted prior to altering this directory structure.

N If the initialization parameters file is changed, the user is responsible for moving any
data files to the new directories. The system will create new empty directories if they
are not available on the startup.

Press the Select ALL button or if the GrandMaster Suite is to reside as a sub directory
under another directory insert a drive letter and major directory name in front of each
of 12 GMSUITE directories.

EXAMPLE:

W:\APPS\PAYROLL\GMSUITE
W:\APPS\PAYROLL\GMSUITE\COMMON

To re-direct the location from the local default Drive C:, Select �Disk Space� button.
A drop down list of available drives and space accessible from this computer will
appear. Highlight the desired drive locations and tick the box to Changes All
Directories. Click �OK�.

Once you have ensured that the GrandMaster Suite of all programs will be directed to
the correct drive, youmayproceedwith the installation by pressing the Install button.
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7. The installation will proceed and the following screen will appear showing the
progress:

8. Once the installation is complete, a message screen will appear advising you
that the GrandMaster Suite installed successfully and that the
CONFIG.SYSfile has been altered to now include GrandMaster Suite. The
message also advises you to shut down and restart your system to activate the
changes. Select �OK�.

9. Select Exit from GrandMaster Suite Installation program.

10.Retrieve CD-ROM from CD-ROM drive and proceed with �Shut Down�.
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OS/2 Installation - Six Diskettes

In the event that you do not have an operating CD-ROM drive you may request a
GrandMaster Suite OS/2 distribution kit. This distribution kit consists of 6 diskettes
for the program installation.

1. Insert Disk 1 into the diskette drive

2. Open an OS/2 window and type A: Install [ENTER]

3. When the necessary files have been loaded the following screen will appear:

4. Press the continue button to proceed with installing GrandMaster Suite or
select the cancel button if you wish to discontinue the installation. Proceeding
with the installation calls up a dialog box which displays the product and
version numbers.
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5. Select the OK button to continue. A dialog box will appear as follows:

6. Select the components to be installed and verify the location for the directories.
There are 12 sub-directories of the GrandMaster Suite directory that will be
created during the installation.

Directory Description

\GMSUITE Root directory for the software. This directory normally

contains the GRAND.INI file for the software.

\GMSUITE\ADMIN Directory containing the system administration data files.

\GMSUITE\COMMON Directory containing the common data files.

\GMSUITE\PAYROLL Directory containing the payroll base data files.

\GMSUITE\HR Directory containing the human resources data files.

\GMSUITE\SCHEDULE Directory containing the scheduling data files.

\GMSUITE\TIMEKEEP Directory containing the time keeping data files.

\GMSUITE\ORGCHART Directory containing the resource planning data files.

\GMSUITE\EFT Directory containing the electronic funds transfer data files.

\GMSUITE\JOBCOST Directory containing the labour distribution data files.

\GMSUITE\BANKREC Directory containing the bank reconciliation data files.

\GMSUITE\RUNTIME Directory containing the executable programs for GrandMaster

Suite.

The directories shown above are created during the installation. Values are stored in
the initialization parameters file �GRAND.INI�.
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The systemadministrator should be consulted prior to altering this directory structure.

N If the initialization parameters file is changed, the user is responsible for moving any
data files to the new directories. The system will create new empty directories if they
are not available on the startup.

Press the Select ALL button or if the GrandMaster Suite is to reside as a sub directory
under another directory insert a drive letter and major directory name in front of each
of 12 GMSUITE directories.

EXAMPLE:
W:\APPS\PAYROLL\GMSUITE
W:\APPS\PAYROLL\GMSUITE\ADMIN

To re-direct the drive location from the local default Drive C:, Select �Disk Space�
button. A drop down list of available drives and space accessible from this computer
will appear. Highlight the desired drive locations and tick the box to �Changes All
Directories�. Click �OK�.
Once you have ensured that the GrandMaster Suite of all programs will be directed to
the correct drive, youmayproceedwith the installation by pressing the Install button.

7. The installation will proceed and the following screen will appear showing the
progress.
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8. Once Disk 1 has been loaded, a prompt will appear to insert Disk 2.

9. Place Disk 2 in the diskette drive and select the �Continue� button. This
process will be repeated for the remaining diskettes. Once all six diskettes
have been installed, a message will appear advising you that the GrandMaster
Suite installed successfully and that the CONFIG.SYS file has been altered to
now include GrandMaster Suite. The message also advises you to shut down
and re-start your system to activate the changes. Select �OK�.

10.Select �Exit� from GrandMaster Suite Installation program.

11.Remove the last diskette from the drive and proceed with the �Shut Down�.
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Installation - License - OS/2

The GrandMaster Suite of programs must be installed before installing your license
disk.
Your license will not be included on the CD-ROM but will be distributed by diskette
for the foreseeable future.
It is important to request and install your license disk if you wish to implement the
system formore than 20 employees. Without a license installed, GrandMaster Suite is
considered a �Demo-For Evaluation� only.

1. Insert License disk into diskette drive

2. Open an OS/2 window and Type A: INSTALL [ENTER]

3. A window will appear indicating that the GrandMaster Suite license
installation program is loading files.

After the loading of the files is completed, the following dialog box will appear which
allows the user to continue with the installation, or exit (Cancel) from the install
process.
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4. Press the �Continue� button to proceed with the installation. The following
screen will appear asking if you wish to install this product.

5. Press �OK� to install the license.

6. Select the components to be installed and verify the locations for the
directories. There are two directories that will be affected during the license
installation.

Press the Select All button or insert major directory name and location in front of each
of the two GMSuite directories.
To re-direct the drive location from the local default drive C:, Select �Disk Space�
button. A drop down list of available drives and space accessible from this computer
will appear. Highlight the desired drive location where Grandmaster Suite programs
were previously installed and tick the box to �Change all Directories�. �Click OK�.

F Ensure that the license disk is installed to the correct drive where GrandMaster Suite
had been installed previously.

7. Select the Install button to install the license.
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8. Once the license installation has been completed, a message screen will appear
advising you that the GrandMaster Suite license installed successfully. The
message also advises you to shut down and re-start your system, however, a
full shut down is not required at this stage.

9. Select Exit and return to your desktop

10.Remove the disk from the diskette drive and store in a safe place.
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Other Installation Considerations

Please review the following topics and recommendations in order to avoid any
difficulties prior to installation of GrandMaster Suite.

n Installation of Software updates

n AUTOEXEC.BAT commands.

n Special note for Windows 95 and Windows NT install.

n Installation of 32 bit software

n DOS and Network file resources

n Windows 3.1 and Windows 95/NT

n Peer to Peer network setup for Windows 95 and Windows NT.

n GrandMaster Suite (32 Bit) considerations and GrandMaster II

n On-Line documentation

n Obtaining software updates - downloaded

Installation of Software Updates

GrandMaster Suite is an integrated set of personnel management software. As such it
is an ever evolving product. There will be ongoing changes in functionality which
will generate new updates to the product being sent to you periodically in addition to
those changes to the payroll module necessitated by changes in tax regulations. These
updateswill be sent to you in your preferred format. Review the preceding installation
techniques for your particular circumstances. Once the software has been installed, an
update proceeds automatically to find the current installation and to update the
programs. The only difference is that the update does not ask you to assign a drive
location since it automatically detects current location. Once an update has completed
successfully there is no requirement to do a full shut down of your system.
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AUTOEXEC.BAT Commands

The path statement must contain the location of the GrandMaster Suite RUNTIME
files.

PATH = C:\GMSUITE\RUNTIME;C:\DOS;C:\WINDOWS

A COBDIR statement must be present that points to the GRANDMASTER Suite
RUNTIME files.

SET COBDIR = C:\GMSUITE\RUNTIME;

F When GMII character mode software is installed the pointer to the GMSUITE
RUNTIME programs must precede the pointer to the GMII programs.

SET COBDIR = C:\GMSUITE\RUNTIME;C:\GRNDMAST;

ACOBHNFstatementmust be present that points to theGrandmaster Suite help files.
SET COBHNF = C:\GMSUITE\RUNTIME;

F When GMII character mode software is installed the pointer to the GMSUITE help
files must precede the pointer to the GMII help files.

SET COBHNF = C:\GMSUITE\RUNTIME; C:\GRNDMAST;

An incorrect COBDIR statement will usually result in the following screen display:

F Novell netware login scripts may over write set commands in the AUTOEXEC.BAT
file. This will cause a start up error.
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Special Note for Windows 95 and Windows NT Install

This release contains a new set of runtime support modules for Windows 95 and
WindowsNT. A special proceduremust be followed to install this update onWindows
95 and Windows NT workstation, if you have previously installed the Windows 3.1
(16 bit) product.
This procedure is only required the FIRST time that theWindows/NT supportmodules
are installed. Subsequent updates can be done by just updating the software without
un-installing the existing software.

1. The existing software must be un-installed using the installation utility.

n Start the GrandMaster Suite Installation Utility from the Start Menu

n Select GrandMaster Suite from the list of products

n Select the Delete action from the Action Menu choice

n Select GrandMaster Suite in the Delete Action Window

n Press the Delete button

The existing software will be removed from your system. After the software is
removed the utilitywill request that a batch file - EPFIDEFI.BAT - be run from the root
directory of your hard drive. This batch file completes the un-install procedure.

2. Insert the CD-ROM with the new software and install the update. Ensure that
the correct drive is selected for the software installation.

3. Re-Start (re-boot) your workstation before using the software.
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Installation of 32 bit Software

When the 32 bit software is installed without first uninstalling the 16 bit software the
GrandMaster Suite programwill not load. When the program is selected from the start
menu or froma short cut the computer systemwill display a �wait� cursor for a fraction
of a second, then the program will not start up.

Problem Resolution

Once the 32 bit software is installed, you cannot uninstall the 16 bit software using the
installation utility. The only way to accomplish the uninstall is to do it manually by
following the instructions given below.

1. Open the MSDOS prompt on Windows 95 or the command line on Windows
NT and change to the drive where you have installed GrandMaster Suite.
D: (if D is where the software is installed)

2. Copy the software license file to the \gmsuite directory
COPY \GMSUITE\RUNTIME\LICENCE.LBR \GMSUITE

3. Delete the files in the \GMSUITE\RUNTIME directory (see NOTE below)
DEL \GMSUITE\RUNTIME\*.*

4. Install the software from the CD-ROM or diskettes

5. Copy the software license file back to the \GMSUITE\RUNTIME directory
COPY \GMSUITE\LICENCE.LBR \GMSUITE\RUNTIME

F On some systems people have experienced problems with deleting files from the
\GMSUITE\RUNTIME directory. If this happens, try re-booting your machine
(shutdown and power off themachine and then power it back on). We are not surewhy
this occurs but it appears to be a problemwithWindows 95 or theNetworkSoftware.

If you still cannot delete the files you can rename the runtime directory to a different
name and create a new runtime directory by entering the following three commands:

1. CD\GMSUITE

2. REN RUNTIME OLDRUN

3. MD RUNTIME
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DOS and Network File Resources

The GrandMaster Suite program may require access to a large number of file handles
for some processing.

You should have your files setting in the CONFIG.SYS system file set to at least 128
when the program is installed on the local hard drive.

When you are using a network (such as )OS/2 Warp Server or Novell you should
ensure that your work station can access at least 128 network files. Consult your
network OS documentation to determine how to do this.

When the number of files that can be accessed is insufficient, the software will display
an error code of 9/14. If this occurs you must allow access to more file handles.

F You may receive several different errors that are caused by the network problems.
Please check with your network administrator for help in resolving these problems.

Windows 3.1 and Windows 95/NT

When a network contains a combination of Windows 3.1 and Windows 95/NT
workstations you must have both the 16 bit and 32 bit windows versions of
GrandMaster Suite available.

The Windows 3.1 workstations must have the COBDIR environment variable
pointing to a directory that contains the 16 bit software. The default working directory
for the workstation should be the directory that contains the 16 bit software.

The Windows 95/NT workstations must have the COBDIR environment variable
pointing to a directory that contains the 32 bit software. The default working directory
for the workstation should be the directory that contains the 32 bit software.

The 16 bit and 32 bit software cannot be installed in the same directory as they have
routines with the same name that are actually different for the 16 bit and 32 bit
software. If they are installed in the same directory they will not operate correctly.
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Peer to Peer Network Setup - Windows 95 and Windows NT

In order to use GrandMaster Suite in a Peer to Peer network environment there are
some steps to take before installing the software. These steps will establish a common
shared drive letter for all workstations that will access the software.

Prime Workstation where GrandMaster Suite will be resident

1. Open the �My Computer� icon and open the �C:� drive

2. Create a folder that will be used to contain the GrandMaster Suite shared
application

n "Right Click� on a blank spot on the drive folder

n From the pop-up menu select �New� then �Folder�

n Type in the name for the folder �GMShare� (press enter after typing the name)

3. Share the folder for the GrandMaster Suite shared application

n Right Click� on a the GMShare folder

n From the pop-up menu select �Sharing�

n On the Properties dialog box that appears

n Check the �Shared� button

n Type �GrandMaster Applications� in the comment field, Press the
�Permissions� button and ensure that any users will access the applications are
granted access

n The default is �Everyone� with �Full Control�

n Press the �OK� button on the Permissions dialog

n Press �OK� on the Properties dialog

n The folder icon will change to indicate that the folder is shared
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On Windows NT
4. Open the �Network Neighborhood� icon and select the Prime Workstation

5. �Right Click� on the �GMShare� folder and select �Map Drive�

n Select a drive letter from the drop down list

n Use the same drive letter on all workstations that access the share

n Check the �Reconnect at Logon� choice

6. Install the GrandMaster Suite software to the drive letter set up in step 5.

On Windows 95
On Windows 95 Peer to Peer Network, you cannot always map a drive to a directory
that is resident on the same machine. For Windows 95, use the following method
instead of mapping a network drive letter.

Edit the AUTOEXEC.BAT file and insert the following command:
SUBST X C:\GMSHARE

Where X is the common drive letter selected for the GrandMaster suite software.

Other Workstations that will access GrandMaster Suite

1. Open the �Network Neighborhood� icon and select the Prime workstation

2. Right Click on the �GMShare� folder and select�Map Drive�

n Select a drive letter from the drop down list

n Use the same drive letter on all workstations that access the share

n Check the �Reconnect at Logon� choice

3. Install the GrandMaster Suite software to the drive letter set up in step 3.
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GrandMaster Suite Windows and GM II

When both of these products are installed on the same workstation with either
Windows 95 orWindowsNT the set up ofGM IImust be changed to allow it to coexist
with GrandMaster Suite.

GM II Setup Considerations

GMII is commonly installed using theGMII-WIN.BAT file to start the program. This
batch file executes the program using XM (an extended memory manager). The
program is running as a DOS application under the Windows 16 bit part of the
operating system.

This can cause problems with the 16 bit GrandMaster Suite software if both
applications are run at the same time. TheXMprogram takes over themanagement of
the 16 bit Windows memory space and can cause the execution to GrandMaster Suite
and potentially other 16 bit Windows application programs - to fail.

The batch file used to execute GM II should be changed to contain the following
commands: (assuming that GM II is installed on the C: drive)

SET SAVEDIR=%COBDIR%
SET COBDIR=C:\GRNDMAST
GRNDMWIN
SET COBDIR=%SAVEDIR%

These commandswill causeGMII to run as aWindows textmode program. TheGMII
screens will be displayed in a window on theWindows 95/NT desktop rather than full
screen.

The font size and other properties of thewindowcan be set by clicking on theWindows
system menu (top left corner of the window). The font size should be set to one that
provides a comfortable display size. The save window settings on exit should be set,
and the do not display application termination dialog should be set. These settings are
available after GM II is started.

TheGRNDMAST.INI file contains a number of settings for the physical port name for
printers. These should be changed to the FormLPTn.DOS;where n is the port number.
(Eg: LPT1.DOS rather thanLPT1:). Thiswill allow reports to print properlywhere the
printer port is captured for routing to a network printer.

TheAUTOEXEC file should not be used to set theCOBDIRvariable for use byGMII.
TheGrandMaster Suite programuses this setting and it should not be used forGMII.
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GrandMaster Suite (32 bit) Considerations and GrandMaster II

When theGrandMaster Suite (32 bit) software is installed, the 32 bit run time software
is incompatible with the GrandMaster II programs.

Any setting of the COBDIR environment variable in the AUTOEXEC file must not
include the GM II Installation directory (normally C:\GRNDMAST). This can cause
the 32 bit GrandMaster Suite software to fail.

The COBDIR environment variable for the GM II programs must be set in a specific
batch file used to start GM II. The commands in this file are discussed in the previous
section.

If the GM II programs access the 32 bit runtime software, the programs will fail to
execute. If you have a set up that includes the following AUTOEXEC environment
variable setting:

SET COBDIR=C:\GMSUITE\RUNTIME;C:\GRNDMAST;

And the GM II program is started through a shortcut that contains the command
C:\GRNDMAST\GRNDMWIN.EXE

TheGMII programwill fail to execute because the order of directories in theCOBDIR
environment variablewill causeGMII to try runningwith the 32 bit runtime software.

If the order of the directories is changed so that the GM II directory precedes the
GrandMaster Suite directory:

SET COBDIR=C:\GRNDMAST; C:\GMSUITE\RUNTIME;

The GrandMaster Suite program may fail to execute correctly.
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On-Line Documentation

The \ACROBAT directory contains the auto-install programs for Acrobat Reader for
Windows 3.1, Windows 95/NT and OS/2. These programs may be installed by
executing the appropriate file.

ARO2E30.EXE for OS/2
AR16E301.EXE for Windows 3.1
AR32E301.EXE for Windows 95

The PDF files in the \DOC directory may be copied to the hard drive if desired or they
can be left on the CD-ROM. If they are left on the CD-ROMyouwill have to have the
CD-ROM in you CD directory to view the documentation.

Obtaining Software Updates

Updates to the software can be downloaded from

Via FTP from: ftp://www.canpay.com
Via HTTP from: http://www.canpay.com/download/

Please consult the RELNOTES.TXT file located in the above locations for changes
and corrections that may affect your operation of theGrandMaster Suite software. We
update both the FTP site and the Web site with new features and fixes on a regular
basis.
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Problems locating the license file

The license file (Licence.LBR) must be located in the \GMSUITE\RUNTIME
directory.
The COBDIR environment variable must point to the \GMSUITE\RUNTIME
directory.
ie: SET COBDIR=D:\GMSUITE\RUNTIME

1. Verify that the license file (LICENCE.LBR) is in the \gmsuite\runtime
directory by using the dos DIR command (DIR
\GMSUITE\RUNTIME\LICENCE.LBR).

2. Verify that the COBDIR environment is pointing to the correct location for the
executable files. The DOS set command can be used to display the
environment variable settings.

You may also edit the AUTOEXE.BAT file to ensure that the SET
\COBDIR=D:\GMSUITE\RUNTIME command is present and points to the correct
location.

F If the command in theAUTOEXEC.BAT file is correct but the SET command shows a
different value, this could result from settings in a Novell Login script or the
equivalent for your network operating system.

F If the command in theAUTOEXEX.BAT file is correct but the SET command shows a
truncated value, this could result from insufficient environment space. The
CONFIG.SYS file should contain a shell command to set the environment space.

For MS-DOS SHELL=C:\DOS\COMMAND.COM C:\DOS/E:4096 /P
ForWIN95SHELL=C:\WINDOWS\COMMAND.COMC:\WINDOWS /E:4096 /P
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THE BASICS

System Startup Processing

When the GrandMaster Suite program is started a window is displayed that contains
the logo and a message that indicates the program is:

�VERIFYING INSTALLATION AND SETUP....�

This stage of the startup scans the system initialization parameters and verifies that all
system data files are available and can be opened for processing.

If a file error is encountered at this stage a message box will be displayed that contains
the name of the file and the associated error codes. Please refer to the file error codes
list to determine the cause of the error and corrective action.

After the verification stage is complete the software license information is displayed
and the user logon dialog box is displayed.

You will be warned when you are approaching the expiry date of your license. Your
program will revert back to 20 employee maximum usage after this date. Be sure to
contact Can-Pay prior to the expiry date for an update to your user license.
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The Basic Elements of the GrandMaster System Manager

The following items appear throughout the GrandMaster System Manager:
n the logon dialog box

n the main screen

n the menu system

n the dialog boxes

n selection lists

n the on-line help system

n printer support

n printer setup

The Logon

The User ID field is used to enter your assigned user ID. If your User ID is not on file
an error message will appear.

The installation process sets up a single User ID �SUPERVISOR� with no password.
This ID should be used the first time the system is used after installation.

F "Supervisor� has been set up with no password and unlimited access.
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The Main Screen

The GrandMaster System Manager has nine modules:

Space has been reserved for future development of an additional module.

Selecting a

Module

To select a module move the mouse cursor over the appropriate button and select it by
clicking the left mouse button once.

Access Letters An alternate method of selecting items involves using access letters. The access letter
is the character of the selection item that is underlined. To activate an item, press the
access letter of the desired item while holding down the ALT key.

Example: To activate thePayroll module, pressALT+P.

F The user may use only the access letters on the current window. The current window
will have a solid colour bar on the top line.
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Main Screen Help

When the user selects the help menu the following screen will appear:

Help The Help menu option will bring up:

Help Index The Help Index will show you an index on the help system

Help Contents The Help Contents will show you a table of contents on the help system

All About

GrandMaster

Suite

TheAllAboutGrandMaster Suitewill showyou a list of topics available to the user.

License The license option will show you your serial #, Validation #, your employee limit and
the date your license expires.

Version Number The version number will show you the current version of GrandMaster Suite you are
using.

Release Notes The Release notes option will bring up a screen of information on the changesmade to
the different modules.
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The Menu System

When the user selects a menu item from amenu bar, a �drop-down�menu is displayed
listing the options available.

An item can be selected by:
n arrowing up or down the menu list to the item and pressing the ENTER key

n pointing and clicking the left mouse button on the desired item

n using the ALT + access character to select the item.

An arrow (®) to the right of an item indicates that selecting this item will give you
further selections.
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Dialog Boxes

Dialog boxes are �windows� in which information may be entered and edited by the
user. The following is a sample of a dialog box:

The user can point and click on any field in the window to change or add information.
To move from field-to-field using the key board press the TAB key or SHIFT +TAB to
move backwards.
To save and exit the screen, click on the OK button, or press the ALT +O. To abort all
changes use the CANCEL button, or press the ALT +C.
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Selection Lists

F8 (list) Positioning the cursor in a field and pressing the F8keywill bring up the corresponding
selection list.
Selection lists allow the user to select an item of information from a list. Usually, when
the user makes an invalid entry in a dialog box, a selection list will appear, displaying
the valid choices.
The following is a sample of a selection list:

OK The OK button confirms selection of the item under the selection bar.

CANCEL The CANCEL button exits the list without a choice.

INSERT The INSERT button allows the user to insert a new item in the list.

UPDATE The UPDATE button allows the user to alter the item under the selection bar.

DELETE The DELETE button allows the user to delete the item under the selection bar.

Double clicking on an item will make a selection and close the list.
Single clicking on an item will highlight the item and then the desired button can be
selected.

F The insert, update, and delete buttons will only appear if the user is granted the
privileges for these actions.
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The On-Line Help System

GrandMaster Suite has a comprehensive on-line help system. This help system is
activated by selecting the Help option on any menu bar or by pressing the help key
(F1).
From any menu bar, the Help menu appears as follows:

HELP Main Menu

Regardless of the method used to access the HELP system the main menu will appear
the same.
The help system dialog box will appear with the screen options across the bottom.
There is a menu option bar at the top, including the help option on how to run help
from the main menu bar. The screen will appear as follows:
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Help Index

This option lists topics pertaining to the operation of System Administrator in
alphabetical order. The user may select one of these topics to receive a more detailed
description of the topic, relevant procedures, and available keystrokes.

Context-sensitive Help

F1 (help) When pressed, F1will display a help screen specific to the active menu, dialog box, or
selection list (context-sensitive). This help screen provides a description of each field
in the active dialog box, and a description of each available keystroke.

F Always try the context-sensitive help before referring to the User's Guide. Not only is
the context-sensitive help faster and easier, it is also updated more frequently than the
User's Guide.

To find out where a particular field is accessed, go to the index window and select the
desired field name from the list.
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Printer Setup

The Printer Setup option allows the user to select a printer, select different fonts,
point size, and select the orientation for the print job.
The following dialog box appears when the Printer Setup option is chosen:

If the gray circle to the left of the choice is highlighted, that indicates the choice is
currently selected. Only one choice for each type of parameter may be selected at any
time.

Saving... The parameters are saved by pressing the SAVE button with the cursor or selecting the
Save option in the File menu.

Use... The parameters are used by pressing the USE button with the cursor or selecting the
USE buttonwith the cursor or selecting theUse option in the File menu. This will be in
effect only while you are currently logged on.

Esc (exit) The ESC key, the CANCEL button, or the Exit option from the File menu will exit the
screen without saving any changes.
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Printer Support

TheGrandMaster Suite accepts the printer setup from the operating system (Windows
or OS/2). Prior to printing a report you should check or be aware of your �DEFAULT�
printer settings. Thewrong settings could cause your columns not to line up or lines to
wrap (over flow to the next line).

The best font for report printing is a monospaced font such as Courier. Proportional
fonts will distort the alignment of the columns in the reports.

Example:

Monospaced font:
(courier)

iiiiiiiiiiiiiii
wwwwwwwwwwwwwww

Proportional font:

(arial)

iiiiiiiiiiiiiii

wwwwwwwwwwwwwww

The user may set the preferred paper orientation and font through the printer setup
dialog from the report menus. The user may also use this dialog to force the
GrandMaster Suite to ask for printer and/or font selection each time a report is printed.

If you have problems with the printing of reports please ensure that you have the
correct printer driver installed for your printer. The use of an incorrect or out-dated
printer driver can cause problems with the appearance and content of the reports.
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Backing Up Your Files

The GrandMaster Suite does not provide a built in back up utility program. It is
recommended that the user obtain and implement a reliable third party backup system.
The data files used by the GrandMaster Suite reside in the directories created during
the installation process or in the alternate directories specified in the initialization
parameter settings.

N With the exception of the \GMSUITE\RUNTIME directory (which contains the
executable programs) these directoriesMUST be backed up as a complete set and/or
restored as a complete set.

N Partial restoration of the data filesWILL destroy the integrity of the system database.
If the integrity of the database is not maintained you may find it necessary to re-enter
ALL affected data.

We recommend that the data directories to be backed up daily and copies of the

data be kept off site.

A disaster recovery plan should be in a place that will allow you to recover from
catastrophic system failures.

The following data directories should be backed up to removable storage device:
n ADMIN Directory

n PAYROLL Directory and Sub Directories

n HR Directory

n SCHEDULE Directory

n TIMEKEEP Directory

n ORGCHART Directory

n JOBCOST Directory

n EFT Directory

n BANKREC Directory

n COMMON Directory

Any individual payroll sub directories must be specifically included in the backup.
GrandMaster Suite allows these files to be located anywhere on your local hard drives
or network. Thesemaynot be included in the payroll directory and its sub directories.
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CONVERSION

The Conversion menu in the Administration module contains functions that are used
to convert files from previous Can-Pay payroll systems to the GrandMaster Suite
payroll.
The functions available are:

n Payroll Conversion (GrandMaster II) - This function converts a
GrandMaster II payroll to a GrandMaster Suite payroll.

F The root directory for GrandMaster II must be defined in the Initialization Parameters
under File in the Administration Module.

n PayrollConversion (GrandMaster I)- This function converts aGrandMaster
I payroll into a GrandMaster Suite payroll.

n ConvertHomeCareClients - This function converts homecare clients data for
the homecare module.
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Payroll Conversion - GrandMaster II

What is converted?

The GrandMaster Suite does the conversion of GM II payrolls to the Suite
data format. The conversion process conserves all settings for the Employer
Information, Employee Information and the Earning, Deduction, and
Accumulator types.
The history contained in the GM II file for the current payroll year is stored in
the Suite permanent history file.

What is NOT converted?

The conversion process doesNOTallowyou to generate a Journal Entry from
the converted data. TheGrandMaster Suite productwill only produce Journal
Entry reports and export files from pay calculations that are done by the Suite
Payroll module. Youmust generate any outstanding journal entry reports and
export files from the GM II software before converting to the GrandMaster
Suite payroll.

Does this process affect my GM II data?

The conversion process has no effect on the GM II data files. The conversion
only reads theGMII database.Nodata is changed in theGMIIdatabase.

Do I have to Clear my GM II payroll.

The conversion process will work on a payroll that has not been cleared after
the last payroll calculation, BUT we strongly recommend that you clear the
GM II payroll before converting the payroll. This will ensure that the GM II
payroll is not re-calculated after the conversion with the possibility that
confusion will occur because the converted payroll does not match the last
GM II payroll calculation.

CAUTIONS

EachGMII payroll should be converted only once.A second conversionmay
duplicate the data from theGM II payroll in the history file if proper steps and
precautions are not taken.
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Conversion Procedure Steps

Action Description
Set the GM II file

location

The location of the GM II root directory must be set up in the

Initialization Parameters settings in the AdministrationModule.

These settings allow the conversion process to locate and list the

GM II payrolls.

Create Suite Payroll Create a GrandMaster Suite Payroll as a destination for conversion.

Select and convert the

payrolls

The Administration module conversion menu is used to start the

conversion process for each payroll.

Confirm the

conversion processing

The Suite Payroll module is used to print the pay registers for the

payroll converted. The Suite payroll can print registers from the

history file so that the conversion of all pay run history in the GM

II payroll can be verified.

Confirm the converted

calculation parameters

Once the transfer of historical data has been verified by printing the

pay register, all flag settings and deductions and accumulator

calculation parameters should be verified.
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Set the GM II file location

The Administration Module menu item FILE contains a menu choice
INITIALIZATION PARAMETERS. This menu choice displays the initialization
parameter settings and allows you to alter those settings. The tab for GM II contains a
field where the location of the GM II root directory is entered.

The GM II directory field must contain the path for the GM II payroll. The default that
is used for the GM II installation is C:\GRNDMAST. If you do not have GM II
installed in the default location change this path to where you have installed GM II.

After entering the location of the GM II directory you must save the new parameter
settings. The FILEmenu has a SAVE choice that will save the initialization parameter
settings. If the settings are not saved the conversion process will not be able to locate
the GM II payroll files.
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Creating the Suite payroll

The Select GrandMaster Payroll file screen shows a list of the existing Suite payrolls.
The new payroll to receive the converted data can be created from the Suite payroll list
screen.

N Do not select a payroll that has existing data as a destination for the conversion. The
conversion processwill corrupt the existing data in the payroll permanent history file.

The Insert button is used to insert a new payroll for the conversion.
The Payroll Name field is used to enter the code for the new payroll. The code name
can be any combination of 10 characters, either alphabetic or numeric.
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TheGrandMaster Payroll File Update screen is displayed when a new payroll is being
created.

This screen allows you to enter a description for the payroll being created and the path
to the data files for the payroll. The path value is initially set to a default generated from
the base payroll data directory and the code for the payroll.
After you enter the description, pressing the OK button will create the new payroll.
Youwill have to select the newpayroll from the list screen after the payroll is created.
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Select and convert the payrolls

The Conversion Process is accessed through the Administration Module
CONVERSION menu. The menu choice PAYROLL CONVERSION (GM II) will
start the conversion process.
The Conversion Process displays a screen that lets you enter the name of the GM II
payroll to convert and the name of the Suite payroll that will be the destination of the
converted payroll data.
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GM II Payroll

The field is used to enter the name of the payroll to convert. A list of the
GM II payrolls can be obtained by pressing the F8 key when the field is
selected.
The following gives a description of the Convert GM II payroll screen:

The GM II payroll selection screen is displayed when the list of payrolls
is requested by pressing the F8 key. The payroll to convert can be
selected by highlighting the payroll on the list and pressing the OK
button.
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GMSUITE

Payroll

The field is used to enter the name of the Suite payroll that will be the destination for
the converted data.
A list of existing Suite payrolls can be obtained by selecting the List option in the File
menu or by pressing the F8 key. The new payroll to receive the converted data can be
created from the Suite payroll list screen.

F We do not support combining payrolls through the conversion process.

Pay Year

This field pay year is used to enter the taxation year that is being converted. Normally,
this field would contain the current year. However, the possibility to convert from a
previous year if the data files are present or if the conversion is taking place during a
transition period at the end of one taxation yearwhere pay date is in following tax year.

Conversion Options

Do Not Convert Summary
History

If you wish to convert only the payroll settings and

employee base information but do not wish to convert the

details from the historical data you may tick this box.

Do Not Convert Detail History This box is ticked if you do not wish to convert the GMII

overrides into transaction details for the payroll history.

Do Not Convert Company Level
Information

This box is ticked if you do not wish to have the company/

payroll level settings in GrandMaster Suite overridden by

the GM2 company level settings. This could be used in the

case where a GrandMaster Suite Payroll has been set up and

tested with new earnings definitions or deductions

parameters and you wish to preserve those settings.

Match Employee Numbers on
File

This box MUST be ticked in the event that a re-conversion

is being processed. If this box is not ticked, duplicated

employee records will occur.

Match Employee Pay
Information

This box may be ticked in the event that a re-conversion is

being processed. This will prevent any employee level

setups in the GrandMaster Suite Payroll from being

overridden by the GM2 employee level settings.

Do Not Convert Employee
Settings

This box may be ticked in the event that a re-conversion is

being processed. This will prevent any employee level

earnings setups and new definitions and parameters from

being overridden by the previous GM2 Employee Level

Settings.

N If you choose the option �DoNotConvert Payroll SummaryRecords�, please consider
the outcome which may result, if you convert the detail transactions but not the
corresponding YTD Summary records. If you convert either transactions or history
YTD records separately and not together, this may result in inconsistent payroll
information.
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Conversion Process

The PROCESS CONVERSION button is used to start the conversion processing. As
the conversion progresses a Conversion Category Correspondence Screen will appear
for certain selections to be made. The conversion program will convert all employee
data fields that are optional in GrandMaster II. Some firms may have implemented
only some or all of these. Therefore, the conversion program presents a list of these
fields for specific inclusion in the conversion process. The following fields will be
presented for conversion to the GrandMaster Suite Category fields:

GM 2 Miscellaneous Page Fields Corresponding GrandMaster Suite

Department Code Category 1

Account Number Category 2

Sub-Account Number Category 3

Position Category 4

Revenue Canada Employment Type Category 5

Optional Field A Contents Category 6

Optional Field B Contents Category 7

There are a number of sort options available in the Suite which will sort reports by
category. By converting the fields in this way, reports such as the pay register can be
sorted by Category 1 - Department Code as an Example. Upon completion of the
conversion, this information can be found on each employee�s �Payroll Specific
Information� Notebook.

Once the conversion category correspondence selections have been made the
conversion will proceed to the next step.

A list of conversion pay periods will next be presented. The screen will present for
confirmation or changing the pay period dates, run number and type of run. i.e.)
Normal, Additional, Extra. If a pay period type must be changed, highlight the one to
be changed and click once. An entry screen will be presented to accept the changes
required. ClickOK to save changes. Once the pay periods list has been reviewed click
OK and the conversion can proceed.

The conversion processwill display the employee names as the payroll is converted.

The payroll conversion process can be quite lengthy depending on the number of
earnings, deductions, accumulators , and the volume of history to convert. If the
conversion is taking place over a network, the network speed and throughput is also a
factor.
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Confirm the conversion processing

After the payroll is converted, we recommend that you print the pay register for the
conversion pay run. This register should be compared to the GM II pay register to
ensure that the payroll history converted correctly.

Reports can also be printed that show the Earning Types, Deduction Types, and
Accumulator Types. The data in these reports can be compared to theGM II settings to
ensure that the data was converted successfully.

F TheGM II earning table is converted to a named earning table in the new payroll. This
table has a different format than the GM II format. All column and row pointers are
changed so that they point to the equivalent data in the Suite earning table.

F The GMII General Ledger account codes have not been converted in such a way that
GrandMaster Suite can produce a Journal Entry without reinputting the General
Ledger Codes into distribution tables. A blank distribution table will have been
created for each different departments reference in GMII. It is recommended that you
reviewyour general ledger reporting requirements prior to setting up your new Journal
Entry Structure. If each employee has a department code assignment, GrandMaster
Suite has created a payroll category for that employee as well as assumed that
employee�s assignment to a base distribution table of that same name or number.

F Any additional information contained in the �Employee�� Miscellaneous�page from
GMII can be found in the Employee�� Ppayroll Specific Information�Notebook under
the Miscellaneous Tab.

N Please review your Revenue Canada Employment Insurance Rate Assignments.
Normally, full rate indicates part time employees or employees who do not receive
qualifying company benefits. The company�s portion of employment insurance
would then be charged at the �Full Rate� of 1.4 times the employee�s EI Deduction.
Reduced rate normally applies to full-time employees or employees who receive
Company benefits approved byHumanResourcesCanada qualifying the company for
a reduced employment insurance rate.

GrandMaster Suite GMII

Full Rate Part Time

Reduced Rate Full Time
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Payroll Conversion - GrandMaster I

What is converted?

The GrandMaster Suite does the conversion of GM I payrolls to the Suite data format.
The conversion process conserves all settings for the Employer Information,
Employee Information and the Earning, Deduction, and Accumulator types.

What is NOT converted?

The conversion process does NOT allow you to generate a Journal Entry from the
converted data. The GrandMaster Suite product will only produce Journal Entry
reports and export files from pay calculations that are done by the Suite Payroll
module. Youmust generate any outstanding journal entry reports and export files from
the GM I software before converting to the GrandMaster Suite payroll.

Does this process affect my GM I data?

The conversion process has no effect on the GM I data files. The conversion only
reads the GM I database. No data is changed in the GM I database.

Do I have to Clear my GM I payroll.

Yes. The conversion process will not work on a payroll that has not been cleared after
the last payroll calculation.

CAUTIONS

It is recommended that each GM I payroll be converted only once. In the event of an
problem, a second conversion can be attempted.
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Conversion Procedure Steps

Action Description
Run the GM2PREP

program

The GM2PREP program reads the payroll that you are going to convert and

writes out a data file from the payroll that the Suite can read. This step is

required because the native file formats of the GM I payroll and the Suite

Payroll are not compatible.

Create GrandMaster Suite

Payroll

Create a GrandMaster Suite Payroll as a destination for the conversion.

Select and convert the

payrolls

The Administration module conversion menu is used to start the conversion

process for each payroll.

Confirm the conversion

processing

The Suite Payroll module is used to print the pay registers for the payroll

converted. The Suite payroll can print registers from the history file so that

the conversion of all pay run history in the GM I payroll can be verified.

Confirm the converted

calculation

Once the transfer of historical data has been verified by printing the pay

registers, all flag settings and deductions and accumulator calculation

parameters should be verified.
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Run the GM2PREP Program

The GM2PREP program is a stand-alone program that reads the GM I payroll master
and writes out an interim file that can be read by the GrandMaster Suite program. The
GM2Prep program is distributedwith the Suite and is located in theGMSuite Runtime
directory during installation.

Your first step will be to copy the GM2Prep program fromGrandMaster Suite to your
CanPay directory where your GM1 payroll files are located. The entire GM2Prep
procedure must be done from a DOS prompt.

If yourCanPay files are resident on a different physicalmachine runningDOSonly the
following procedure will apply for preparing your GM1 files for conversion to
GrandMaster Suite.

1. On the computer where GrandMaster Suite has been installed, insert a diskette
into diskette drive A:

2. From a DOS prompt Type:

COPY C:\GMSUITE\RUNTIME\GM2PREP.EXE A:

3. A message should appear advising you that 1 file has been copied.

4. Remove the diskette and label with contents and date.

Ie: GM2PREP.EXE June 30, 1998

F Use the correct drive letter where GrandMaster Suite is installed to copy from if it is
different than C:

5. On the DOS computer where CanPay GM1 files are resident insert
GM2PREP.EXE diskette into Drive A.

6. From a DOS prompt Type:

Copy A:\*.* C:\CANPAY

7. A message should appear advising you that 1 file has been copied.

8. Remove diskette and store.

F Use the correct drive letter where Canpay GM1 is installed to copy to if it is different
than C:

9. On the DOS Computer where CanPay GM1 files are resident insert a blank
diskette into Drive A.

10.From a DOS prompt go to the CanPay directory

CD\Canpay

11.Run the GM2Prep program type:

GM2Prep [ENTER]
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12.The Program will display a screen that allows you to enter the name of the
payroll to convert. This is the normal name that you use for your payroll.

13.After requesting the name of the payroll to convert the program will ask for the
file-name to use for the conversion data file. Make a note of this file name
because you will need it later.

14.Type A:\Filename This will over type the contents pre-assigned in this field.

15.This will take very little time to process

16. If you have more than one payroll to convert leave diskette in Drive A, use
your F3 key to repeat the command and press enter.

17.Repeat steps 12 to 15 inclusive.

18.When all payrolls have been copied to the diskette. Remove the diskette and
label and date it appropriately.

19.Type Exit [ENTER]

20.Exit DOS

21.The diskette you have created here will be inserted in the diskette drive of the
computer where GrandMaster Suite is installed and the conversion will be run
referencing the drive location.

If your CanPay files are resident on the same physical computer that GrandMaster
Suite has been installed on the following procedures will apply. It is extremely
important to note the correct drive location of both programs in completing these steps.

1. From a DOS prompt type:
Copy ?:\GMSUITE\RUNTIME\GM2PREP ?:\CANPAY where question mark
represents the drive letter locations of both programs. You would replace
question mark with the appropriate drive letter.

2. A message should appear advising you that 1 file has been copied.

3. You must now run the GM2Prep program from the CanPay directory on
whatever drive. ?: [ENTER] CD\CANPAY

4. Type : GM2PREP
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5. The program will display a screen that allows you to enter the name of the
payroll to convert. This is the normal name that you use for your payroll.

6. After requesting the name of the payroll to convert, the program will ask for
the destination drive and file name to use for the conversion data file. The
name used here should be noted since it will be required later.

7. Type ?:\File Name This will overtype the contents preassigned in this field.

8. This takes very little time to process

9. If you have more than one payroll to convert, use your F3 key to repeat the
command and press enter.

10.Repeat steps 5 to 8 inclusive

11.When complete, type: exit [ENTER]

12.Exit DOS
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Creating the Suite payroll

The Select GrandMaster Payroll file screen shows a list of the existing Suite payrolls.
The new payroll to receive the converted data can be created from the Suite payroll list
screen.

N Do not select a payroll that has existing data as a destination for the conversion. The
conversion processwill corrupt the existing data in the payroll permanent history file.

The Insert button is used to insert a new payroll for the conversion.
The Payroll Name field is used to enter the code for the new payroll. The code name
can be any combination of 10 characters, either alphabetic or numeric.
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TheGrandMaster Payroll File Update screen is displayed when a new payroll is being
created.

This screen allows you to enter a description for the payroll being created and the path
to the data files for the payroll. The path value is initially set to a default generated from
the base payroll data directory and the code for the payroll.

After you enter the description, pressing the OK button will create the new payroll.
Youwill have to select the newpayroll from the list screen after the payroll is created.
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Select and convert the payrolls

The Conversion Process is accessed through the Administration Module
CONVERSIONmenu. Themenu choice PAYROLLCONVERSION (GMI)will start
the conversion process.

The Conversion Process displays a screen that lets you enter the name and path of the
GM I payroll data file that was output from the GM2PREP program and the name of
the Suite payroll that will be the destination of the converted payroll data.

The screen offers two options for processing the file conversion. TheDoNot Convert
Transactions is ticked if you do not want to convert the GM I transactions for the
payroll history.

F If a previous conversion ran into some difficulty a reconversion can be processed only
if the match employee numbers is checked!

GM2PREP

OutPut File

The field GM2PREP File is used to enter the name of the data file for the payroll to
convert and the drive location if necessary such as in the case where you created a
separate diskette from GM2PREP.

Suite Payroll The field Suite Payroll is used to enter the name of the Suite payroll that will be the
destination for the converted data.
A list of the existing Suite payrolls can be obtained by selecting the List option in the
File menu or by pressing the F8 key. The new payroll to receive the converted data can
be created from the Suite payroll list screen.

F We do not support combining payrolls through the conversion process.
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Conversion Process

The PROCESSCONVERSION button is used to start the conversion processing. As
the conversion progresses a Conversion Category Correspondence Screen will appear
for certain selections to be made. The conversion program will convert the employee
year to date pay data and most of the employee personal data. There are however,
some data fields that are optional in GrandMaster I. Some firms may have
implemented only some or all of these. Therefore, the conversion program presents a
list of these fields for specific inclusion in the conversion process. The following field
will be presented for conversion to the GrandMaster Suite category fields.

GM 1 Employee Record Fields Corresponding GrandMaster Suite
Categories

Department Category 1

Account Category 2

Position Category 3

Revenue Canada Employment
Type

Category 4

Company Code Category 5

It is suggested that the fields be selected by using the up and down arrows and
highlighting in sequential order. The department code from GrandMaster I would be
converted to the Grand Master Suite Category 1. There are a number of sort options
available in the Suite which will sort reports by category. By converting the fields this
way, reports such as the pay register can be sorted byCategory 1 -Department Code as
an example. Upon completion of the conversion, this information can be found on
each employee�s �Payroll Specific Information� notebook.

Once the conversion category correspondence selections have been made the
conversion will proceed to the next step.

A list of conversion pay periods will next be presented. The screen will present for
confirmation or changing the pay period dates, run number and type of run, i.e.:
Normal, Additional, Extra. If a pay period or type must be changed, highlight the one
to be changed and click once. An entry screen will be presented to insert the changes
required. Click OK to save the changes. Once the pay period list has been reviewed
click OK and the conversion can proceed.

Since GrandMaster I does not store any run history except the last one, the Suite
extrapolates the dates from the last run dates and the pay frequency but it assumes all
runs are normal. If there have been additional or extra pay runs, these will not be
reflected in the pay period correctly and the run numbers may be dated back into the
previous year. The pay period list must be carefully reviewed and amended where
necessary.
The conversion processwill display the employee names as the payroll is converted.
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The payroll conversion process can be quite lengthy depending on the number of
earnings, deductions, accumulators , and the volume of history to convert.
If conversion is taking place over a network, the network speed and through put is also
a factor. If the conversion is reading the files to be converted from the diskette drive,
this may be somewhat slower.

Confirm the conversion processing

After the payroll is converted, we recommend that you print the pay register for the
conversion pay run. This register should be compared to the GM I pay register to
ensure that the payroll history converted correctly.
Reports can also be printed that show the Earning Types, Deduction Types, and
Accumulator Types. The data in these reports can be compared to the GM I settings to
ensure that the data was converted successfully.

N In some cases it has been noted that rates expressed as percentages in GM1 do not
transfer correctly to GrandMaster Suite due to a different processing technique in both
programs. The numerals will be correct but the placement of the decimal point may
not be. Please carefully review all deduction parameters and make any adjustment
prior to running your first calculation.

F The GM I earning table is converted to a named earning table in the new payroll.

F The GM1 General Ledger Account codes have not been converted in such a way that
GrandMaster Suite can produce a Journal Entry without inputting the General Ledger
codes into the distribution tables. A blank distribution table will have been created for
each different department reference in GM1. It is recommended that you review your
General Ledger reporting requirements prior to setting up your new Journal Entry
structure. If each employee had a department code assignment, GrandMaster Suite
has created a payroll category for that employee as well as assumed that employee�s
assignment to a base distribution table of that same name or number.

N Please review your Revenue Canada Employment insurance rate assignments.
Normally, full rate applies to part-time employees or employees who do not receive
company benefits. The company�s portion of employment insurance would then be
charged at the �Full Rate� of 1.4 times theEmployee�sDeduction for E.I. Reduced rate
normally applies to full time employees or employees who receive company benefits
approved by Human Resources Canada qualifying the company for a reduced
Employment Insurance portion rate.

GrandMaster Suite GM1

Full Rate Partime

Reduced Rate FullTime
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Convert Homecare Clients

The Convert Homecare Clients option is used to load data from a comma delimited
ASCII file (CSV format) into the homecare client database.

The screen presented contains the names of the data fields that can be converted and a
field that represents the fields position in the input data record.

A position number must be entered for any data field that will be updated to the
homecare client database. The position number is the sequential position that the field
occupies in the import file. (eg) If the field is 5th in the list of fields in the file, it�s
position number is 5.

The dialog box will appear as follows:
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The data fields contained in this screen are:

Field Description

Input File This field contains the name and location of the import file.

Account This field is for entering a position number for account number field.

Last Name This field is for entering a position number for last name field.

First Name This field is for entering a position number for first name field.

Address 1 This field is for entering a position number for the address line one field.

Address 2 This field is for entering a position number for the address line two field.

City This field is for entering a position number for the city field.

Province This field is for entering a position number for provinces field.

Province Set This field is for the preset province code.

Postal This field is for entering a position number for postal code field.

Phone 1 This field is for entering a position number for phone number field.

Phone 2 This field is for entering a position number for additional phone numbers field.

Sex This field is for entering a position number for the individuals sex code field.

Birth Date This field is for entering a position number for birth date field.

Medicare This field is for entering a position number for medicare number field.

Area This field is for entering a position number for area code field.
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New Customers of GrandMaster Suite Payroll

We recognize that there is a great deal of data entry work which must be done in order
to implement the GrandMaster Suite payroll when you are not converting from one of
our own Canay Computer Software Ltd�s other payroll products. We have provided
some functions that will permit the import of employees� personal information and
their current year to date balances.

These functions are not available in the Adminstration Module but rather can be
accessed from the Payroll Module directly.
We refer the user to Chapter 3 - Data of our Payroll Manual.

In order to initiate these import functions it will be necesary for the user to complete
the Company/Payroll level setups. Effectively, a payroll should be as completely set
up as possible in order to create a destination for the data to be imported to. We
strongly recommend spending the time to set up employee templates. A template can
be used to set up each employees� set of predefined earnings, deductions and
accumulators at the time of adding an employee to a payroll. This will save on the set
up time.

Import Employee Names:

1. Create an Export file from your current system, usually with a file extension
of .txt. Note the drive location and exact file name.

2. Go to GrandMaster Suite Payroll Module

3. Under File; Select your payroll that you are importing to

4. Under Data; Go to Import/Export functions

5. Select Import Employee Names

6. Insert the drive location, if necessary, and your Export directory and File name
and extension.

7. Indicate whether it is a fixed length or comma delimited file that has been
exported.

8. Indicate the Date format in the Export file

9. GrandMaster Suite is a date based system and uses a 4 digit year format. Other
systems however may not store the year as 4 digits but rather 2 digits. It will
be necessary to indicate the century that the Import applies to by completeing
the year option field. This function indicates to the system the conversion of
the two digit years to four digit years. The program will determine the first
two digits for the four digit year using a formula expressed in the �Year
Option� box. When the incoming year is greater than or equal to the value in
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the �If Year>= Field the first two digits of the four digit year will be the value
in the �Century is� field.
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When the incoming year is less than the value in the �If Year>=� Field the first two
digits of the four digit year will be set to the value in the �Century is� field plus 1.
It is necessary to complete this function in order for birth dates and inital hire dates to
be translated correctly.

10.Select either comma delimited tab or fixed length record tab of notebook and
indicate the record position or location of field to import.

11.Once you are satisfied that you have completed the notebook, ensure that your
default printer is �ON� and �ONLINE�. A report of the import file will be
automatically generated.

12.Press Process

13.A file of Employee�s names and Personal information has been created in the
Suite. However, there is a further step to insert these people into the
GrandMaster Suite payroll. Please refer to �Add an Employee� function in the
�Payroll� or �Human Resources� manuals.

14.Once your employees have been added to the GrandMaster Suite Payroll, you
may then proceed to import their year to date history data from your current
system.

15.Create an Export file from your current system. Note the drive location and
exact File name.

16.Go to GrandMaster Suite Payroll Module

17.Under File, Select the Payroll that you are importing to.

18.Under Data, go to Import/Export functions

19.Select �Import Pay Adjustments�

20.Please refer to the �Payroll� manual for further instructions.

21.Once your Year to Dates have been successfully imported we suggest that you
print a payroll register to confirm your imports are complete. See �Payroll�
Manual section on �Reports�.
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MANAGING ADMINISTRATION

The AdministrationModule allows the users to configure the GrandMaster Suite and
assign privileges to the users. This module should only by used by a supervisor who
has knowledge of the computer system configuration and network.

The GrandMaster Suite is amulti-user systemwith the applications all linked together
to provide common access to the information. The modules and files of the
GrandMaster Suite can be spread about the network and must be controlled by a
system administrator.

The system administrator using the Administration module can:

1. Change system configuration

2. Add, change, or delete users

3. Convert GrandMaster I, and GrandMaster II payrolls to the GrandMaster Suite
payroll

4. Set overall operating parameters

5. Run special utility programs
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Main Administration Module

The Administration main menu provides access to define the user ID's, global
preferences, general ledger codes, and initialization parameters. Thismenu also gives
the user access to perform conversions, and start up specialized utility functions ( only
needed by some users).
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When the user selects theAdministration filemenu the following screenwill appear:

The File menu offers the following functions to the user:
n creating user ID's, setting up passwords, and defining the privileges for each
user ID

n setting up global preferences which apply to all users

n defining all general ledger codes

n entering the data directory for the data files

n modifying the initialization parameters for the Suite

Can-Pay Computer Software 93

MANAGING ADMINISTRATION - 5

M
A

N
A

G
IN

G
A

D
M

IN
IS

T
R

A
T

IO
N



Update User ID's

The Update User ID's option allows the user to create and/or update the user ID list.
When the user chooses theUpdateUser ID's option a dialog box appears as follows:

F8 (list) The F8 key or the List option will display a list of the existing user ID's and names.

F The list will only contain all the ID's and names if the User ID field is blank when the
List option is selected. Otherwise, only the names of the ID specified in the User ID
field will appear in the list that is created. Select a name from the list by double
clicking with the mouse.

Or, to add a new user ID(for creating or adding a new name to an existing list) type the
ID name in the User ID field, and press the OK button.
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This action will bring up a new dialog box:

TheUserName tab screen is used to enter the users name and to set the users password.

The user is to enter the nameof the person corresponding to the ID. The time of the last
logon will appear at the bottom.
The following table gives a description of the screen:

Field Description

Name This field is used to enter the name of the user.

Last Logon This field displays the last time the user logon.

Set Password This field is used to set the password of the user.

Saving... When the name has been entered use the SAVE button or the Save option in the File
menu.

Esc (cancel) The CANCEL button, theExit option in the File menu, or the ESC key is used to exit the
screen without saving any changes made within the screen.

Select All The SELECTALL buttonwill turn on all the privileges available on all the user privilege
screens within the notebook.

F The individual notebook pages are used to update privilege settings for each specific
module.
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Setting a Password

Use the Set Password button to set a password. The following dialog box will appear
when this button is selected:

F The password and confirmation of the password will not be visible when it is being
entered. Please note whether upper or lower case is used at the time of establishing a
password. It will be necessary to enter the password exactly as saved.

Saving... The OK button will save the password and exit from the screen.

Esc (exit) The ESC key or the CANCEL button are used to exit from the screen without saving any
changes.
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Restricting Access

TheModule tab opens the page of the notebook that is used to set which modules are
accessible by the different users. The Module tab screen appears as follows:

To set user privileges:
1. Select the module(s) by clicking once on the name or box of the desired

module(s) with the mouse. A check mark will appear in the box of the selected
module.

2. Use the tabs to select any module(s) previously selected in step one. This will
bring up the screen(s) in which the parameters are set within the appropriate
module(s), for the user .

F Selected modules (those with check marks) will be accessible to the user.

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving
any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen
without saving any changes.

Select All The SELECT ALL button does not turn on all the modules to be accessed. It will be
necessary to specifically designate which modules can be accessed.
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Common Data Privilege Settings
The Common tab screen is used to update commonly used privileges for the user. The
common tab screen appears as follows:

The following table gives a description of the screen:

Field Description

Employee This group of check boxes determines if the user can add, change, or delete

employee's in the database.

Calendar This group of check boxes determines if the user can add, change, or delete

calendar items in the database.

Object This group of check boxes determines if the user can add, change, or delete

objects in the database.

G/L Codes This group of check boxes determines if the user can add, change, or delete

G/L codes in the database.

Position This group of check boxes determines if the user can add, change, or delete

positions in the database.

Object Group This group of check boxes determines if the user can add, change, or delete

object groups in the database.

Leaves This group of check boxes determines if the user can add, change, or delete

leave items in the database.
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Saving... The SAVE button or the Save option in the File menu will exit the screen after saving
any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen
without saving any changes.

All The ALL button will turn on all the options available on the current user privilege
screen.

Select All The SELECTALL buttonwill turn on all the privileges available on all the user privilege
screens within the notebook.
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Payroll Data Privilege Settings
The Payroll tab screen is used to update payroll privileges for the user. The payroll
screen appears as follows:

The following tables gives a description of the screen:

Field Description

Payroll
Employee

This group of check boxes determines if the user can add, change, or delete

payroll employee's in the database.

Deductions This group of check boxes determines if the user can add, change, or delete

deductions in the database.

Payrolls This group of check boxes determines if the user can add, change, or delete

payrolls in the database.

Earnings This group of check boxes determines if the user can add, change, or delete

earnings in the database.

Accumulators This group of check boxes determines if the user can add, change, or delete

accumulators in the database.

Audit Trail This option determines if the user can use the audit trail function.

Calculate
Payroll

This option determines if the user can calculate payroll.

Change
Company

This option determines if the user can change company information.

View Payroll
Data

This option determines if the user can view payroll data.

View Pay Rates This option determines if the user can view pay rates.

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving
any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen
without saving any changes.
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All The ALL button will turn on all the options available on the current user privilege
screen.

Select All The SELECTALL buttonwill turn on all the privileges available on all the user privilege
screens within the notebook.
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H/R Data Privilege Settings
TheH/R tab screen is used to updateHumanResource privileges for the user. TheH/R
screen appears as follows:

The following table gives a description of the screen:

Field Description

Incidents This group of check boxes determines if the user can add, change, or delete

incidents in the database.

Position
Assignment

This group of check boxes determines if the user can add, change, or delete

position assignments in the database.

Availability This group of check boxes determines if the user can add, change, or delete

availability in the database.

Item
Assignment

This group of check boxes determines if the user can add, change, or delete

item assignment in the database.

Skill This group of check boxes determines if the user can add, change, or delete

skills in the database.

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving
any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen
without saving any changes.

All The ALL button will turn on all the options available on the current user privilege
screen.

Select All The SELECTALL buttonwill turn on all the privileges available on all the user privilege
screens within the notebook.
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Schedule Data Privilege Settings
The Schedule tab screen is used to update Scheduling privileges for the user. The
Schedule screen appears as follows:

The following table gives a description of the screen:

Fields Description

Generate Detail
Schedule

This option determines if the user can generate a detail schedule.

Update Rotation
Table

This option determines if the user can update the rotation tables.

Update Shift Table This option determines if the user can update the shift tables.

Modify Detail
Schedule

This option determines if the user can modify a detail schedule.

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving
any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen
without saving any changes.

All The ALL button will turn on all the options available on the current user privilege
screen.

Select All The SELECTALL buttonwill turn on all the privileges available on all the user privilege
screens within the notebook.
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Time Keeping Data Privilege Settings
The Time Keeping Tab screen is used to update Time Keeping privileges for the user.
The Time Keeping screen appears as follows:

The following table gives a description of the screen:

Fields Description

Enter
Employee

Time

This option determines if the user can enter employee time.

Enter Hours
by Earning

This option determines if the user can enter hours by earning.

Close Actual
Period

This option determines if the user can close off the actual.

Update Hours
to Payroll

This option determines if the user can update the hours to payroll.

Earning
Translation

This group of check boxes determines if the user can add, change, or delete

earning translation tables in the database.

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving
any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen
without saving any changes.

All The ALL button will turn on all the options available on the current user privilege
screen.

Select All The SELECTALL buttonwill turn on all the privileges available on all the user privilege
screens within the notebook.
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Resource Planning Data Privilege Settings
The R/P tab screen is used to update Resource Planning privileges for the user. The
Resource Planning screen appears as follows:

The following table gives a description of the screen:

Field Description

Relationships This group of check boxes determines if the user can add, change, or delete

relationships in the database.

Relationship
Category

This group of check boxes determines if the user can add, change, or delete

relationship categories in the database.

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving
any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen
without saving any changes.

All The ALL button will turn on all the options available on the current user privilege
screen.

Select All The SELECTALL buttonwill turn on all the privileges available on all the user privilege
screens within the notebook.
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Selection Group Data Privilege Settings
The Groups Tab screen is used to update selection group privileges for the user. The
Group screen appears as follows:

The following table gives a description of the screen:

Fields Description

Selection Group
Maintenance

This option determines if the user can perform maintenance on selection

method of the group.

Selection Group
Load

This option determines if the user can load selection groups.

Modify Current
Selection

This option determines if the user can modify the current selection group.

Add Selection
Group

This option determines if the user can add a selection group.

Change Selection
Group

This option determines if the user can change a selection group.

Delete Selection
Group

This option determines if the user can delete a selection group.

Force Use of
Selection Group

This option restricts the user to only the default selection group of

employees.

Default Selection
Group

This is used to enter the name of the employee group that the user will

have loaded for them when they logon to the GrandMaster Suite.
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Saving... The SAVE button or the Save option in the File menu will exit the screen after saving
any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen
without saving any changes.

All The ALL button will turn on all the options available on the current user privilege
screen.

Select All The SELECTALL buttonwill turn on all the privileges available on all the user privilege
screens within the notebook.
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User Defined Data and Screen Definition Privilege Settings
TheDefine Tab screen is used to update User Defined data privileges for the user. The
Define screen appears as follows:

The following table gives a description of the screen:

Field Description

Data Group This group of check boxes determines if the user can add, change, or delete

data groups in the database.

Screen
Definition

This group of check boxes determines if the user can add, change, or delete

screen definitions in the database.

Screen
Groups

This group of check boxes determines if the user can add, change, or delete

screen groups in the database.

Data
Definition

This group of check boxes determines if the user can add, change, or delete

data definitions in the database.

Data
Records

This group of check boxes determines if the user can add, change, or delete

data records in the database.

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving
any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen
without saving any changes.

All The ALL button will turn on all the options available on the current user privilege
screen.

Select All The SELECTALL buttonwill turn on all the privileges available on all the user privilege
screens within the notebook.
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Custom Report Privilege Settings
The Reports tab screen is used to update custom report privileges for the user. The
Reports screen appears as follows:

The following table gives a description of the screen:

Field Description

Define Custom
Reports

This option determines if a user can define custom reports.

Generate Custom
Reports

This option determines if a user can generate custom reports.

Saving... The SAVE button or the Save option in the File menu will exit the screen after saving
any changed data.

Esc (exit) The ESC key, CANCEL button, or Exit option from the file menu will exit the screen
without saving any changes.

All The ALL button will turn on all the options available on the current user privilege
screen.

Select All The SELECTALL buttonwill turn on all the privileges available on all the user privilege
screens within the notebook.
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Global Preferences

This option is used to set processing parameters that apply to all users. Selecting the
Global Preferences option will bring up the following screen:

Global Types

Enabled

The check box is used to turn the use of global earnings, deductions, and accumulators
on or off.
The Earning Search list allows the selection of the search technique used to resolve
the pay rate for an employee.

n The selection �Position Search� uses the position codes as the primary
qualification to resolve a pay rate.

n The selection �Earning Search� uses the earning code as the primary
qualification to resolve a pay rate.
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G/L Code

Treaments

Both theG/L Code Treatmentswill verify if the G/L code is in the proper format, as
set in the General Ledger Definition option (see page 112), but only the Validation
G/L Codes option will check if the G/L code is on file.

n If theValidationG/LCodes is turned on theG/L codewill be looked forwithin a
G/L code validation file. If the code does not appear in this file a message will
appear saying the code does not exist in the file.

n If the Parse G/L Codes is turned on the G/L code will be checked for proper
format. If the code is not in the proper format a message will appear saying the
code has an invalid format.

Position Rates for

GMII

When the Position Rates for GMII is turned on the position pay tables are used to
determine the pay rate for hours being updated to the GMII payroll through Time
Keeping.

Save The Save option in the File menu, or the OK button will save any changes made to the
data in the screen.

Esc (exit) TheESCkey, theExit option in the Filemenu, or theCANCELbuttonwill exit the screen
without saving any changes made to the data in the screen.
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General Ledger Definition

Selecting theGeneralLedgerDefinition optionwill open the following dialog box:

The general ledger code format may contain one or more segments of various lengths
that total a maximum of sixty characters.
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The following table describes the fields contained within the General Ledger Code
Definition screen:

Field Description

Number of
Parts

This field specifies the number of parts for the general ledger code. There can

be a maximum of eight parts.

Fill This field indicates what type of fill is to be put in if there is any blank space

within a part of the general ledger code. The fill can be either a zero or a

space.

Separator The separator indicates what character, if any, will separate the parts of the

code. This can be any character on the keyboard.

Length The length specifies the number of characters within a part. The general ledger

code can be a maximum of 60 characters long. Thus a part can be from zero to

60 characters long, but the sum of all parts must not exceed 60 characters.

Type The type defines whether the each part is right or left justified.

Saving... The Save option in the File menu, or the OK button will save any changes made to the
data in the screen.

Esc (exit) TheESCkey, theExit option in the Filemenu, or theCANCELbuttonwill exit the screen
without saving any changes.
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Initialization Parameters

The following dialog box will appear when the Initialization Parameters option is
selected:

Each page of the notebook contains the data directory for the data files and a check box
to indicate that the module is �installed� (available to the users).

The �INI File� field contains the name of the file inwhich the initialization parameters
will be saved. This file name is used in the definition of the program start up icon. It
follows the name of the executable file to tell the program what set of initialization
parameters to use.

If you are running payrolls or other modules for separate companies you may wish to
have a different �INI� files for each company to keep the employee files completely
separate and confidential.
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The following notebook pages are available:

Notebook Page Description

Admin Contains the name and location of the administration and common data

directories. A check box is available to mark the administration module as

available to users. This check box should normally be �checked�.

Payroll Contains the name and location of the main payroll directory and a check

box to mark the module as available to the users.

H/R Contains the name and location of the main human resources directory and

a check box to mark the module as available to the users.

Schedule Contains the name and location of the main directory and a check box to

mark the module as available to the users.

TimeKeep Contains the name and location of the main time keeping directory and a

check box to mark the module as available to the users.

Res. Plan Contains the name and location of the main resource planning directory and

a check box to mark the module as available to the users.

EFT Contains the name and location of the main electronic funds transfer

directory and a check box to mark the module as available to the users.

BankRec Contains the name and location of the main bank reconciliation directory

and a check box to mark the module as available to the users.

Lab. Dist. Contains the name and location of the main labour distribution directory

and a check box to mark the module as available to the users.

GMII Contains the name and location of the main GMII payroll directory. Also

contains a check box indicating that GMII is installed as an active live

payroll. Used by a very limited number of current Can-Pay Computer

Software LTD.�s customers.

Operation A check box is available to turn on the �Debug� mode. This is normally

not checked.
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Use... TheUse... option in the File menu will temporarily save any changes made to the data
on the screen. These changes will be lost when the user logs off the system, thus the
changes are only applied to that specific session on GrandMaster Suite.

Saving... The Save option in the File menu will permanently save any changes made to the data
on the screen.

Esc (exit) The ESC key or the Exit option in the File menu will exit from the screen without
saving any changes.
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UTILITIES

The Utilities menu contains general purpose utility programs that are released by
Can-Pay Computer Software Ltd. or third party suppliers.
This menu currently contains a general purpose Start Utility Program option.
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Start Utility Program

The Start Utility Program is used to start specialized utility functions that may be
released to some users.
The utility programs that are started with this option are NOT part of the general
release software and should only be used on the direction of your support
representative.

N DO NOT USE THIS OPTION TO �PLAY WITH� YOU MAY EXECUTE A
FUNCTION THAT WILL RESULT IN DAMAGE TO YOUR DATA FILES.

The following screenwill appearwhen theStartUtilityProgramoption is selected:

Program Name The name of the utility program to be started should be entered into this data field.

Start Program The START PROGRAM button starts the program which was entered into the program
name field.

Exit The EXIT button or the Exit option from the file menu exits the option.

A list of current utility programs and a brief description included in the Grandmaster
Suite of programs follows.
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Utility Programs

UTACCADD Utility to add a pay run�s accumulator balances to the next pay run. This is used to
recover fromproblemswith balance carry forwards in someversions of the software.

UTACCDTH Utility to MOVE the DOLLAR accumulator balance to the HOURS accumulator
balance. This is used to support GMII conversions where the accumulator balance
could not be resolved as hours. This problem usually occurs because the accumulator
calculation code has been set to number 5 (no calculation), the calculation code is used
to determine what accumulator balance is in GMII.

UTAVALHD Utility used to re-value an accumulator. The program will use the hour balance of the
accumulator multiplied by the pay rate from the accumulator Prime Earning to set the
DOLLAR balance of the accumulator. This action is equivalent to the hour Based
Revaluation option in the accumulator settings.

UTAVALDH Utility used to re-value an accumulator. The program will use the DOLLAR balance
of the accumulator divided by the pay rate from the accumulator Prime Earning to set
the HOUR balance of the accumulator. This action is equivalent to the Dollar Based
Revaluation option in the accumulator settings.

UTBYPFIX Utility program to change �Bypassed� transactions to �Processed� transactions or
�Processed� transactions to �Bypassed�. This is a special use utility created to fix the
transaction status error caused by a bug in the payroll processing.

UTCA4POS Utility program to use the code value in the Employee Category 4 field to set the
employee base position. This was a special use program created to support some
conversions from GMII payrolls.

UTCATDIS Utility program to use the code value in the Employee Category 1 field to set the
employee base Distribution code. This was a special use program created to support
some conversions from GMII payrolls.

UTCHKEMP Utility program to verify the integrity of the Employee data file, the Employee to
Payroll cross reference file and the Payroll Employee master file. The program will
detect any inconsistencies andwill insert records to ensure the cross reference between
employees and the payrolls are correct. The programcan be used to recover from loops
in the payroll calculation process when an employee data record has been deleted and
the employee shows as an active member of a payroll.

UTCLREMP Utility program to DELETE employee data records when the Employee data record is
not crossed referenced to a payroll.
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UTEMPDAT Utility program to clean up the employee initial, start and end dates in the payroll
master file. This was a special use program created to support some conversions from
GM1 and GM2 payrolls.

UTHISDEL Utility program to DELETE an employee�s pay history from a selected pay run. This
is a special support utility used to clean up after problems encountered in some GM2
conversions. IT SHOULD NOT be used unless you know EXACTLY what you are
doing.

UTHRSDEL Utility program to DELETE the GENERATED transaction from a pay calculation
from the pay hour transaction file. This utility is used to support the re-run of pay
calculations after an earlier version of the pay history file is restored. This utility used
correctly can assist in recovery of a lost payroll history file without requiring the
rekeying of transactions for the pay.

UTJEFGEN Utility program to re-process the journal entry data for a pay run. The program allows
you to set different options for the distribution of benefits according to the distribution
codes entered for the employee earnings.

UTMAKREV Utility to generate initial review records for employees. The program generates the
review for 90 days after the employee start date and used the review type code �3
MTH�.

UTPAYHRS Utility to generate an EXPORT data file containing the transactions for permanent
earnings and keyed hourly earnings whose extended amount does not equal the
amount calculated from the current rate of pay and the number of hours in the
transaction.
The records in the export file contain the number of hours from the original recordwith
an amount that is equal to the difference between the calculated amount and the
original amount, and the rate equivalent to the difference between the original rate and
the current pay rate.
The exported transactions can be imported and used as input to a Retro Pay calculation
run.

UTRATKIL Utility program to completely ERASE any Earning, Deduction, or Accumulator type
definitions that are marked as Deleted.

UTRENJEF Utility program to renumber the Journal Entry file

UTRENPHR Utility program to remember the Payhour file

UTRENUMB Utility program to renumber the Pay History file.
The utilities can be used to add 100 to all the pay sequence numbers for a payroll. The
program is usually used to insert pay sequence before the �first� run so EI history can
be added to a new payroll set up. The inserted pay sequence numbers are dated

120 Can-Pay Computer Software

6 - UTILITIES



according to the number of pay periods in effect and the dates on the �first� pay
sequence.

UTSETHRS Utility program to set the �Units� value in employee Earning type records to a
specified value. This was a special use program created to support some conversions
from GM1 and GM2 payrolls.
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APPENDIX

File System Errors

On occasion you may encounter a system problem which display a file access error
dialog box. We have provided a summary list of these codes and their reason for
occurrence and possible action to be taken. In some cases, the remedy may be as
simple as exiting the software but at other times the system may be advising of a
serious hardware limitation such as not enough disk space remaining on your hard
drive to perform the task assigned. It is extremely important to note the error code
reference and the path and full file name where the error occurred.
File system errors are displayed in a message box that contains the full path of the file
name and a two part error code.
The message box will appear as follows:

Any file error will close down the GrandMaster Suite application.
The following list of error codes is provided to help you diagnose the problem.
One of the file errors

ERROR CODE 1:=9
ERROR CODE 2:=41

can rarely be corrected using the rebuild utility. Please consult the rebuild section for
instructions on using this utility.

N We recommend that you always restore your backup files if you encounter a file

error. The rebuild utility is NOT a data recovery tool.
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Error Codes

File Status 9x

9/nnn - Extended file status code as shown below:

nnn Reason for Error Action to Correct Error

001 Insufficient buffer space. On OS/2, could

indicate that the SWAPPATH has not been

set correctly or the SWAPPATH drive is

full. Could also indicate an out of memory

situation.

If a lot of other applications are running on

the workstation, end them and re-try the

operation.

002 File not open when access tried Contact Can-Pay.

003 Serial mode error Contact Can-Pay.

004 Illegal file name. May result from an invalid path in the

initialization parameters.

005 Illegal device specification. May result from an invalid path in the

initialization parameters.

006 Attempt to write to a file opened for input. Contact Can-Pay.

007 Disk space exhausted. You have filled up your disk drive or

exceeded your disk quota on your network.

Free up some disk space and restore your

backup files.

008 Attempt to input from a file opened for

output.

Contact Can-Pay.

009 No room in directory (also, directory does

not exist).

Network error or setup limitation.

010 File name not supplied. Contact Can-Pay.

012 Attempt to open a file which is already

open.

Contact Can-Pay.

013 File not found. Check initialization parameters.

014 Too many files open simultaneously. Operating system file limits exceeded.

Review file statements (refer to system

resources).

015 Too many indexed files open. Operating system file limits exceeded.

Review file statements (refer to system

resources).

016 Too many device files open. Operating system file limits exceeded.

Review file statements (refer to system

resources).

017 Record error: probably zero length. Will result if previous operations resulted in

a �disk full� condition or processing was

interrupted by system crash or hardware

fault. Correct hardware faults or free up disk

space depending on the conditions, then

restore your most recent back up.
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nnn Reason for Error Action to Correct Error

018 Read part record error: EOF before EOR or

file open in wrong mode.

Will result if previous operations resulted in

a �disk full� condition or processing was

interrupted by system crash or hardware

fault. Correct hardware faults or free up disk

space depending on the conditions, then

restore your most recent back up.

019 Rewrite error: open mode or access mode

wrong.

Contact Can-Pay.

020 Device or resource busy. Network error.

021 File is a directory. Possible network or operating system error.

022 Illegal or impossible access mode for

OPEN.

Possible network or operating system error.

023 Illegal or impossible access mode for

CLOSE.

Possible network or operating system error.

024 Disk I/O error. Possible network or operating system error.

025 Operating system data error. Possible network or operating system error.

026 Block I-O error. Possible network or operating system error.

027 Device not available. Possible network or operating system error.

028 No space on device. Possible network or operating system error.

029 Attempt to delete open file. Contact Can-Pay.

030 File system is read only. Network or operating system error.

031 Not owner of file. Network or operating system error.

032 Too many indexed files, or no such process. Contact Can-Pay.

033 Physical I-O error. Hardware error.

034 Incorrect mode or file descriptor. Network or operating system error.

035 Attempt to access a file with incorrect

permission.

Network or operating system error.

036 File already exists. Network or operating system error.

037 File access denied. Network or operating system error.

038 Disk not compatible. Network or operating system error.

039 File not compatible. Network or operating system error.

040 Language initialization not set up correctly. Contact Can-Pay.

041 Corrupt index file. File information has been destroyed or

corrupted, due to an improper shut down,

system crash or hardware fault. Correct

situation with hardware, if appropriate, and

restore your backups.
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nnn Reason for Error Action to Correct Error

042 Attempt to write on broken pipe. File information has been destroyed or

corrupted, due to an improper shut down,

system crash or hardware fault. Correct

situation with hardware, if appropriate, and

restore your backups.

043 File information missing for indexed file. File information has been destroyed or

corrupted,due to an impropert shut down,

system crash or hardware fault. Correct

situation with hardware, if appropriate, and

restore your backups.

045 Attempt to open an NLS file using an

incompatible program.

Contact Can-Pay.

047 Indexed structure overflow. (Could indicate

that you have reached the maximum

number of duplicate keys.)

Contact Can-Pay.

065 File locked. May occur if file backup software is

processing a file required by the application.

066 Attempt to add duplicate record key to

indexed file.

Contact Can-Pay.

067 Indexed file not open. Contact Can-Pay.

068 Record locked. Re-try operating without other users logged

on.

069 Illegal argument to ISAM module. Contact Can-Pay.

070 Too many indexed files open. Contact Can-Pay.

071 Bad indexed file format. Restore your most recent backup.

072 End of indexed file. Restore your most recent backup.

073 No record found in indexed file. Restore your most recent backup.

074 No current record in indexed file. Contact Can-Pay.

075 Indexed data file name too long. Contact Can-Pay.

077 Internal ISAM module failure. Restore your most recent backup.

078 Illegal key description in indexed file. Restore your most recent backup.

081 Key already exists in indexed file. Restore your most recent backup.

100 Invalid file operation. Restore your most recent backup.

101 Illegal operation on an indexed file. Restore your most recent backup.

102 Sequential file with non-integral number of

records.

Restore your most recent backup.

104 Null file name used in a file operation. Contact Can-Pay.

105 Memory allocation error. Contact Can-Pay.

129 Attempt to access record zero of relative

file.

Contact Can-Pay.

135 File must not exist. Contact Can-Pay.

138 File closed with lock - cannot be opened. Contact Can-Pay.
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nnn Reason for Error Action to Correct Error

139 Record length or key data inconsistency. Restore your most recent backup.

141 File already open - cannot be opened. Contact Can-Pay.

142 File not open - cannot be closed. Contact Can-Pay.

143 REWRITE/DELETE in sequential mode

not preceded by successful READ.

Contact Can-Pay.

146 No current record defined for sequential

read.

Contact Can-Pay.

147 Wrong open mode or access mode for

READ/START.

Contact Can-Pay.

148 Wrong open mode or access mode for

WRITE.

Contact Can-Pay.

149 Wrong open mode or access mode for

REWRITE/DELETE.

Contact Can-Pay.

151 Random read on sequential file. Contact Can-Pay.

152 REWRITE on file not opened I-O. Contact Can-Pay.

158 Attempt to REWRITE to a line-sequential

file.

Contact Can-Pay.

159 Malformed line sequential-file. Contact Can-Pay.

161 File header not found. Restore your most recent backup.

173 Called program not found. Contact Can-Pay.

180 End-of-file marker error. Restore your most recent backup.

182 Console input or console output open in

wrong direction.

Contact Can-Pay.

183 Attempt to open line sequential file for I-O. Contact Can-Pay.

188 File name too large. Contact Can-Pay.

193 Error in variable length count. Restore your most recent backup.

194 File size too large. Restore your most recent backup.

195 DELETE/REWRITE not preceded by a

READ.

Contact Can-Pay.

196 Record number too large in relative or

indexed file.

Contact Can-Pay.

210 File is closed with lock. Contact Can-Pay.

213 Too many locks. Contact Can-Pay.

218 Malformed MULTIPLE REEL/UNIT file. Contact Can-Pay.

219 Operating system shared file limit

exceeded.

This error normally occurs when too many

applications are sharing file on a network file

server. The file server setup should be

reviewed by your network administrator.
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OVERVIEW

The File Management utility, Rebuild, provides a number of facilities to improve the
management of data files. The principal facilities offered are:

n indexed file reorganization.

n recovery of corrupt indexed files.

Indexed File Reorganization

As indexed files are updated, by adding, deleting and altering records, the index and
data structures become disjointed, making processing less efficient. In addition, space
left by deleted records is not always reused, thusmaking the file bigger than it needs to
be. After a large number of changes have been made, it is worth reorganizing an
indexed file to rebuild the data and indices in an ordered sequential fashion and
reclaim any free space, thus providing optimum performance and integrity.

Recovery of Corrupt Indexed Files

An index can become corrupt if, for example, a power loss occurs when a program has
opened and changed an indexed file, but has not yet closed it. If a COBOL program
subsequently attempts to open this file, then the Run Time System (RTS) will detect
that the file was not closed properly and will return a file status error for �Corrupt
Index file�. You cannot use the file at all without first recovering its integrity.
Rebuild can recover corrupt indexed files for you. If the data portion of the file is intact
and only the index portion is corrupt, then Rebuild can generate a new index (.idx file)
from the data with no information loss. If the data portion of the file is corrupt then
Rebuild can rebuild a complete new indexed file, both data and index portions, but
there will be a loss of information as Rebuild discards any corrupt data records that it
encounters.
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Rebuild file Index Utility

The rebuild utility may be used to recover from certain file system errors. Even when
the rebuild procedure completes successfully there is no guarantee that no loss of data
may have occurred. Your first and only sure recovery method should be your backup
files.
The build utility requires exclusive use of the files. Ask all other users to exit out of the
Suite before attempting a recovery.
The most common use is to rebuild a file index when a 9/41 error has been
encountered.
The command line would be:
REBUILD path\filename /v
Where path\filename is the name of the file that was displayed in the file system error
message box.
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OPERATION

TheRebuild utility is a non-interactive utility, which accepts all of its parameters from
the command line, or from parameter files named on the command line. See the
sectionParameter Files later in this chapter for details of how to create a parameter file.

F The �/� characters shown in the following formats for introducing parameters are for
DOS, Windows and OS/2. On UNIX, please replace these �/� characters by �-�
characters.

The format of the command line for rebuilding an index is:
rebuild in-file [/c..] [/k..] [/i] [/v] [/e]

and for reorganization:
rebuild in-file,out-file [/c..] [/d] [/x..] [/i] [/v]

where:
n in-file is the nameof the file, including its extension, to be rebuilt/reorganized.

n out-file is the name of the file, including its extension, to contain the result.
The root of the file-name must be different from that of in-file.

n /c specifies the type of compression to enable on a file.

n /d causes Rebuild to continue from the beginning of the next record if it finds
that the data part of a record in an indexed file is corrupted.

n /e prevents an illegal duplicate key from aborting the Rebuild process.

n /i causes Rebuild to display information.

n /k defines the key structure of the output file.

n /n causes Rebuild to display information without processing the file.

n /r defines the record structure of the input file and output files.

n /t specifies the index file format of the output file.

n /v causes Rebuild to display a running record count.

n /x indicates the key-of-reference.

The utility assumes that an index rebuild is required instead of a reorganization if no
output file is specified. A rebuild with no options can only be achieved if the key
information in the index file is not corrupt. If the index part (.idx) of the indexed file
does not exist, then it is possible to completely rebuild it by additionally specifying a
key structure option. This process alsomakes it possible to replace the key structure of
an existing indexed file with an alternative structure, simply by running Rebuild in
this mode with a new key specification. Environment variables named in-file or
out-file cause filename mapping.
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Rebuild Options

Various options are available with the Rebuild utility. These are described below.
Some of the options are followed by parameters providing the information. The option
letter can be separated from its parameters by an optional colon (:). Options may be
placed anywhere within the command, and are free-format with spaces allowed
between any fields.

/c
The /c option allows the specification of compression on files. The parameters are the
letter d for data compression followed by an integer, and the letter i for index
compression followed by an integer. The integer for data compression must be in the
range 0 to 255 where 0 denotes no compression, values of 1 through 127 are reserved,
and 128 through 255 are for user-defined compression routines. The integer for index
compressionmust be in the range 0 to 7which corresponds to the type of compression:

n 1 - compression of duplicates

n 2 - compression of leading characters

n 4 - compression of trailing spaces

You can specify any combination by adding these values together. Zero (0) specifies
no index compression.

Example:

/c:d1i7 Specifies data compression routine 1, and index compression of leading
characters and trailing spaces.
This compression option is the one used in GrandMaster Suite.
/ci1 Specifies index compression of duplicates only.

Data compression applies only to an output file; index compression can apply to an
output file or the rebuild of an existing file. The /c options operate in a similar manner
to the Compiler directives DATACOMPRESS and KEYCOMPRESS. Refer to the
appendix Directives for Compiler for details of the values available.
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/d
The /d option causes Rebuild to continue from the beginning of the next record if it
finds that the data part of a record in an indexed file is corrupted. If the /d option is not
set, Rebuild returns file status error 9/18 (Read part record error: EOF before EOR or
file open in wrong mode) when it encounters a corrupted record.
When the /d option is specified, the input file's file header is read in and the output file
is given the same attributes.
This option works best with decompressed files which give 9/18 errors when
rebuilding. Rebuild does try to recover other file types but its resulting output may not
be what you are expecting.
If you specify other Rebuild options (for example, /k) with the /d option, then the other
options take precedence over the details in the file header.

/e
When rebuilding a corrupt file, or a file with a new key structure (/k option used),
records may be encountered with an illegal duplicate key. Without the /e option this
causesRebuild to terminatewith an �Error on output file - status 22" error. However, if
the /e option is used, Rebuild reports the duplicate, and continues to process the
remaining records. Note that the record with the duplicate key is not written.

/i
When the /i option is selected, Rebuild will display information about the input and
output files, including record lengths, file type and key structure.

F It is not possible to obtain information about a file without actually invoking one of the
operations.

Example: The information for the index rebuild:

rebuild mast/i
Rebuild successful - records read=49
File : MAST
Largest record length - 353 Smallest record length - 353
Average record length - 353 Organization - Indexed Recording mode - Fixed
Maximum record length - 353 Minimum record length - 353
Keys description: Start char Length Key - 0 1 +9
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/k
The /k option defines the key structure for an indexed file. This is used for rebuilding
the index of an indexed filewhere the index part is missing or corrupt. The parameters
for this option define the keys. The definition of a key is separated from the definition
of the next key by a colon (:). Each key can be defined as a number of parts (split key),
each part being separated by a comma (,). The key part is defined by start character
position and length in characters, separated by a plus (+) or L. Alternate keys (those
other than the first defined) can be terminated by an additional parameter, the character
d, if they are defined asWITHDUPLICATES. The first character position in a record
is position 1.

Example:

/k:1+20
defines a single key, starting at character position 1, length 20 characters
/k:5+5:20+1d:40+2,43+10
defines three keys, the third being split, and the second allowing duplicates. The first
key, the record key, starts at character position 5, length 5; the second key, an alternate
key allowing duplicates, starts at 20, length 1; and the third key, a split alternate key,
has two parts, the first starting at 40, length 2, the second at 43, length 10.

This option applies only to an existing file, unless you are using it to create an index for
a relative or sequential file (see the sectionThe /oOption) forwhich you are allowed to
specify an output file.

/n
The /n option causesRebuild to display information about the file, as for /i, butwithout
doing any other processing on the file.

/o
The /o option defines the organization of the file to be converted. If the parameter is
omitted, indexed is assumed. The organization is identified by a single letter
parameter, as follows:
/o:s sequential /o:r relative /o:i indexed (the default)
The output file has the same organization as the input file, but in a format suitable for
this COBOL system. However, you can create indexed files from sequential and
relative files by adding the letter i after the s or r. To create an index, you specify the
key structure with the /k option. The index file along with its data part is created
separately to the original, so you must specify a name for the output file.
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Example:

/o:ri/k:1+2:3+10d
converts a relative file into an indexed file with the key structure specified.

F Notes: Files of the format used by this COBOL system which are processed by
Rebuild must have a variable structure file header. Therefore, fixed length sequential
or fixed length relative files are not processed because they do not have variable
structure file headers.

You can create fixed length sequential or relative files with variable structure file
headers by retaining the record length information in the COBOL creating program
and by adding a RECORDING MODE IS VARIABLE clause to the FD of your
program.

/r
The /r option defines the record lengths and recording mode of a file. Usually, this
information is obtained by Rebuild from the input file and transferred directly to the
output file. However, when converting to and from Btrieve format files using the /s
and /t options, you must consider the following. Some index file features are
implemented differently by Btrieve. An example is that Btrieve does not store the
maximum record length. Therefore, on conversion from a COBOL format file to a
Btrieve file and back again, certain record length and recordingmode information can
be lost. This makes the file unreadable to a COBOL program using the original file
description. Using the /r option, you can specify the record length and recordingmode
information on the command line when converting to retain the correct record
definitions. You can determine the correct options from the COBOL format file using
the /n information option.

Example:

/r:f record-length
Specifies a fixed length record format with records of length record-length; for
example, /r:f100.
/r:v min-record-length max-record-length
Specifies a variable length format with the maximum and minimum record lengths
separated by a hyphen; for example, /r:v100-200.
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/s
The /s option is for converting file formats used by other COBOL system to the format
used by this system. You specify the input file format as follows:

Format Description

/s:btrv Btrieve format.

/s:c-isam C-ISAM format.

/s:lii LEVEL II V2.5 COBOL format.

/s:mf Format used by this COBOL system.

/s:mf4 Duplicate key format used by this system.

Example:

/s:c-isam
converts a C-ISAM format file into the format used by this system.

By default the output file is in the format used by this system, but this option can be
used in conjunction with the /t option to convert from one file format to another while
reorganizing the file at the same time.You cannot use this option to rebuild a corrupt or
deleted index of a C-ISAM, a LEVEL II V2.5 COBOL or a Btrieve format file by
means of a command line such as:

rebuild infile.dat /s:c-isam

Only indexed files in the format used by this system can be rebuilt. You should use the
/s option to convert your files into this format so that they can be rebuilt in the event of
corruption.
When rebuilding the index of a duplicate key format (mf4) file, you should specify the
/s:mf4 option on the command line otherwise Rebuild attempts to process the
command line as if it is a normal format file (mf).

Example:

rebuild infile.dat /k:1+10:10+2d /s:mf4

I/O operations on Btrieve files are performed by a separate Btrieve file handler. You
must invoke this before Rebuild performs any conversions involving Btrieve files. If
you do not, error 9/27 (Device not available) is returned. See your Btrieve
documentation for details of how to set up and invoke the Btrieve file handler.
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/t
The /t option allows the specification of the index file format of the output file. You
specify the output file format as follows:

Format Description

/t:btrv Btrieve format.

/t:c-isam C-ISAM format.

/t:lii LEVEL II V2.5 COBOL format.

/t:mf Format used by this system.

/t:mf4 Duplicate key format used by this system.

This option applies only to an output file so out-file must be specified.
I/O operations on Btrieve files are performed by a separate Btrieve file handler. You
must invoke this before Rebuild performs any conversions involving Btrieve files. If
you do not, error 9/27 (Device not available) is returned. See your Btrieve
documentation for details of how to set up and invoke the Btrieve file handler.

/v
When the /v option is present, Rebuild will display a record count which it increments
as it processes the file. This is useful if you want to keep track of how Rebuild is
progressing.

N Do not use the /v option if you are redirecting the output.

/x
The /x option defines the key-of-reference, which is used to define the order in which
the data will be written when reorganizing an indexed file. The parameter for this
option is the number of the key to be used. The record key is 0, the alternate keys are
numbered, starting at 1, in the order they are specified in the SELECT statement in the
creating program. If no /x option is specified then the record key (key 0) is assumed.

Example:

/x:2
causes the data to be organized in the order specified by the second alternate key in the
SELECT clause of the creating program.
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Examples of Operation

rebuild badms001.dat, ms001.dat/i

- reorganizes the given file, assuming it is an indexed file in the format used by this
system. The data will be written in the order of the record key, and information
displayed when the reorganization is complete.

rebuild badms001.dat, ms001.dat/x:3

- reorganizes the given file, assuming it is an indexed file in the format used by this
system. The data is written in the order of the third alternate key.

rebuild ms001.dat

- rebuilds the index of the given file, assuming it is an indexed file in the format used by
this system, and that the index (.idx) file is still present, and the key information held
therein is not corrupt.

rebuild ms001.dat/k:1+20/i

- rebuilds the index of the given file, assuming it is an indexed file in the format used by
this system. The index (.idx) file does not need to exist, and is ignored if it does. It will
be completely recreated using the key definition specified on the command, which
need not correspond to the key definition used when the file was created. Information
about the file will be displayed when the rebuild ends.

rebuild infile.dat,outfile.dat /t:btrv

- converts a file in a format used by this COBOL system to a Btrieve format file.
rebuild infile.dat,outfile.dat /s:btrv /t:mf
/r:v12-20

- converts a Btrieve format file to a format used by this COBOL system and sets the
recordingmode to variable, theminimum record length to 12 and themaximum record
length to 20.

rebuild infile.dat, outfile.dat /s:c-isam /c:d1

- converts a C-ISAM format index file into the format used by this system and
compresses the data part.

rebuild infile.dat, outfile.dat /o:ri /k:1+2:3+10d
/c:i7

- generates an index with all types of key compression for a relative file.
rebuild infile.dat, outfile.dat /s:lii /t:lii

- reorganizes a LEVEL II V2.5 COBOL format file and retains the LII structure on the
output file. It is possible to combine /s and /t with other formats in a similarmanner.

set data=\tmp.dat rebuild data /i

- reorganizes and displays information about the file \tmp.dat.
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Parameter Files

At any point on the command line, an at character (@) followed by a file-name
indicates that parameters should be taken from the named file. The contents of the file
are treated as if they were part of the command line, replacing the @file-name.
The parameter file is an ASCII text file. The parameters can be specified in
free-format, with spaces being non-significant. (Line ends are treated as spaces.) The
file must not be bigger than 1024 bytes. Comments can be included in the file by
preceding them with an asterisk (*). Anything following the asterisk is treated as a
comment, up to the end of the line.

Example:

rebuild badms001.dat, ms001.dat @ms001.par
where ms001.par is an ASCII text file containing the following line:
/k:1+20, 25+5:40+12:60+3, 85+10d
or the following lines (which are equivalent to the line above):
*Works master file - key parameters /k: 1+20 * prime key - first part 25+ 5 : * -
second part 40+12 : * 1st alternate key 60+ 3 , * 2nd alternate key (with duplicates)
* - first part 85+10d * - second part

If a parameter in a parameter file is in error, then a suitable message is displayed. The
parameter file line in error is not displayed, but the command line is.
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Redirection of Information

All information displayed by the utility can be redirected to a text file using the
standard operating system redirection, for creating a new file and > for extending an
existing file. Hence, the results of a number of rebuilds in a batch stream can be
collected as the stream is processed, and viewed on completion.

Example:

rebuild oldms001.dat,ms001.dat /k:1+20 /i rebuild.prt rebuild oldrt549.seq,rt549.seq
/i > rebuild.prt rebuild badms001.dat,ms001.dat@ ms001.par > rebuild.prt
causes the information for all three operations to be placed in the text file, rebuild.prt,
one after the other. This can be viewed later using a text editor or the operating system
TYPE command.

F Note that you must not use the /v option when you are redirecting output.
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General Notes

1. We recommend you to take a backup copy of the file being rebuilt or
reorganized before using Rebuild. Rebuild takes every precaution to prevent
the original files being corrupted, but it can happen if the command line is
incorrectly specified. Also, when doing an index rebuild, the original index is
overwritten, so it would be wise to preserve it in case there are any subsequent
problems. For indexed files in the format used by this system, you should save
both the data and the index (.IDX) file.

2. The facility to rebuild the index of an indexed file does not retain the
information held in the original about free space in the data file (Data Free
Space Record). Consequently, this free space cannot be reused and your file
may grow bigger than necessary. To overcome this problem you are
recommended to reorganize the file after you have rebuilt the index, thus
removing all of the free space.

(Free space consists of the spaces in the data file occupied by deleted records.
Information about these areas is normally retained, and the areas reused for new
records as appropriate.)

3. When the rebuild process is complete, the data file is changed because a blank
Data Free Space Record is added to the end of the file. Each time you rebuild
the index a new record is added. Consequently, several rebuilds, without
intervening reorganizations, cause the data file to grow. Again, this problem
can be eliminated by reorganizing the file, causing all the Data Free Space
Records to be removed, and a single new blank one added. (See the appendix
File Formats for more details about indexed file structures.)

SYSTEM PARAMETERS

A set of special parameters can be specified immediately following Rebuild on the
command line. These parameters are present for use during development, testing and
support of Rebuild. Each parameter consists of two slashes followed by a letter
followed by a space.

F The �//� characters are for DOS,Windows and OS/2. OnUNIX, please replace �//� by
���.

//q prevent banners from being displayed
//v display version number of Rebuild program itself
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ERROR, INFORMATION AND WARNING MESSAGES

Rebuildwill output anError, Information orWarningmessage if you do not specify the
correct command line when rebuilding, converting or reorganizing an indexed file.
The following sections list thesemessageswith an explanation of themessage and, for
Error and Warning message, a solution.

Errors

When an error is encountered, the command line is displayed, followed by an error
message. For command line errors, a caret () is displayed under the point in the
command line that the error was detected. The program sets the return code to a value
other than zero to indicate the type of error that has occurred. The code can be tested in
a batch file using the IF ERRORLEVEL command.
The most likely cause of errors is specifying parameters to Rebuild that do not
correctly represent the input file. Inmost cases it is difficult for the utility to determine
that such amistake has beenmade, since most data files carry insufficient information
tomake them easy to identify. Consequently, the error presented by the utilitymay not
obviously identify the cause.

Command Line Errors:

If a command line error occurs, the return code will be set to 9.
***Invalid parameter combination

n The parameters specified on the command line are not compatible with each
other. The return code is set to 9.

n Specify valid parameters for the options you want to use.

/k option is required for conversion to indexed file
n No key definition was given for the index of the file being generated from a
sequential or relative file.

n Specify a key definition.

Data compression out of range
n The integer you specified for data compression is not within the allowable
range.

n Data compression requires an integer in the range 0 through 255.

Data compression specified more than once
n You have specified the option for data compression more than once; that is,
/c:[dn][dn]

n The correct format is /c:[dn][in]

Input file same as output file
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n You have given the output file the same name as the input file.

n The output file-name must be different from the input file-name.

Index compression out of range
n The integer you specified for index compression is not within the allowed
range.

n Index compression requires an integer in the range 0 to 7.

Index compression specified more than once
n You have specified the option for index compression more than once; that is,
/c[in][in].

n The correct format is /c:[dn][in].

Invalid command - /n not allowed with Microsoft format file
n You have specified the /n option for a Microsoft format file which you cannot
do unless the Microsoft format file has been converted into the indexed file
format used by this system.

You must either reenter the command line without the /n option, or convert the
Microsoft format file to the indexed file format used by this system and enter the
command line again.
Invalid command - must specify output file for conversion

n You have omitted an output file-name for a conversion.

n You must specify an output file-name when you want to convert a file to a
different format.

Invalid command line
n The command line contains an error other than those described above.

n Check carefully the syntax, spelling, and spacing in the command line you are
trying to enter.

Invalid compression choice - must be 'd' or 'i'
n The specification of data or index compression was not correct.

n When youwant to specify data or index compression, youmust specify the d or
i parameters.

Invalid format
n The integer you specified for index file format is not within the allowable
range.

n Index file formats require an integer in the range 0 to 4.

Invalid key length - cannot be zero
n One of the keys you defined has a zero length,which is illegal. (Thismay be due
to incorrect use of separator characters.)

n Make sure that any keys you define have a valid start character.
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Invalid key specification - key not contained in record
n Oneof the keys, as defined, is notwholly contained in the record. This is illegal.

n For variable length records, the key must be wholly contained in the
minimum length record.

Invalid key start - cannot be zero
n One of the keys defined has a start character position of zero, which is illegal.
(This may be due to incorrect use of separator characters.)

n Make sure that any keys you define have a valid start character.

Invalid key structure - '+' expected
n A key part parameter of the /k option is incorrect.

n It must be start character position and length separated by a plus (+) or L.

Invalid option
n You have specified an invalid option.

n The options you can specify are described earlier in this chapter.

Invalid organization
n The syntax of the /o option is incorrect.

n The only valid organizations you can specify with the /o are s (sequential), r
(relative), or i (indexed).

Invalid organization - 'i' or nothing expected
n The syntax of the /o option is incorrect.

n The only valid characters after the i, s or r are the letter i (when converting to an
indexed file) or a '/' (when another option is specified).

Invalid organization - must be indexed for index rebuild
n You have tried to rebuild the index of a file whose organization is sequential or
relative.

n Make sure that the file-nameyou enter for rebuilding is that of an indexed file. If
it is not, the rebuildwill fail. See the section The /oOption earlier in this chapter
for further information.

Invalid organization - must be indexed for reorganization
n You have tried to reorganize a file index for a file whose organization is
sequential or relative.

n Make sure that the file-name you enter for reorganization is that of an indexed
file. If it is not, reorganization will fail. See the section The /o Option earlier in
this chapter for further information.

Invalid record length - cannot be zero
n You have specified that the length of a record is zero. This is invalid.
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n When specifying record lengths, you must specify a length greater than zero
which falls within the limits for record lengths for this COBOL system. See the
appendix File Formats later in this manual for further details.

Invalid record lengths - maximum must not be less than minimum
n The integers you have used to specify themaximumandminimum lengths of
a record indicate that the maximum length is less than the minimum length.
This is invalid.

n Reenter the maximum or minimum record length again, ensuring that the
maximum length is greater than the minimum length.

Invalid record parameter - '-' expected
n When specifying the record structure of a variable length file, you have not
separated theminimum record length and themaximum record lengthwith a '-'.

n The correct format is /r:Vminreclen-maxreclen

Invalid record type - 'F' or 'V' expected
n You have entered record type other than fixed or variable. This is invalid.

n Reenter the record type using either f (fixed) or v (variable).

Invalid source format
n The format of the /s option is incorrect.

n See the section The /s Option earlier in this chapter for details of the valid
format and parameter to specify with this option.

MS2X specified for non-indexed file
n Youhave specified that youwant to convert aMicrosoft COBOL indexed file
when that file is not indexed.

n Make sure that you are using the /s option and the correct parameter. See the
Compatibility Guide for details of this option.

Must have key definition (/k option) with MS2X
n The Microsoft key file is not present.

n Youmust specify the /k option to enableRebuild to set up the keys for this file.

No output file specified for /t to refer to
n You did not specify a name for the output file which was referred to with the /t
option.

n Specify the name of an output file for this option.

No output file specified for data compression
n You did not specify an output file-name for data compression.

n Specify a valid output file-name.

Number expected
n You have specified another character where a number was expected.
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n Specify a numeric value for this parameter.

Output file was not specified for indexed output
n No name was given for the output file in conversion to an indexed file.

n Specify an output file-name.

Parameter file not found
n The parameter file specified on the command line cannot be found.

n Check the file exists, and the specification used on the command line is correct.

Rebuild Errors:

***Error on input file - bad file structure
n The structure of the input file is not an indexed file in the format used by this
system. The return code is set to 1.

n Ensure that the parameters are correct and that the file is not corrupt.

***Error on input file - Communications failure
n This error occurs if you have an Fhredir configuration which tells Rebuild to
access files through Fileshare Version 2 (an add-on product).

n Remove this configuration.

***Error on input file - Disk input output error
n This indicates a hardware fault. You should contact your system administrator
if you receive this error.

***Error on input file - disk space exhausted
n File processing cannot continue because there is insufficient disk space to do
so.

n Ensure that the input file is not corrupt. The output file is closed and should be
usable, if not complete.

***Error on input file - duplicate key - record not written:
n The duplicate key was not written to the output file as this would have created
an invalid duplicate.

***Error on input file - file is not a BTRIEVE indexed file
n The file specified by /s:btrv was not recognized as a Btrieve indexed file. The
return code is set to 1.

n Make sure that the file you specify is a Btrieve indexed file.

***Error on input file - file is not a C-ISAM indexed file
n The file specified by /s:c-isam was not recognized as a C-ISAM indexed file.
The return code is set to 1.

n Make sure that the file you specify is a C-ISAM indexed file.
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***Error on input file - file is not an LII indexed file
n The file specified by /s:lii was not recognized as a LEVEL II V2.5 COBOL
indexed file. The return code is set to 1.

n Make sure that the file you specify is aLEVEL IIV2.5COBOL indexed file.

***Error on input file - file is not an MF indexed file
n The file specified by /s:mfwas not recognized as anmf indexed file. The return
code is set to 1.

n Make sure that the file you specify is an mf indexed file.

***Error on input file - file is not an MF4 indexed file
n The file specified by /s:mf4 was not recognized as an mf4 indexed file. The
return code is set to 1.

n Make sure that the file you specify is an mf4 indexed file.

***Error on input file - file is not a variable relative file
n The file specified by /o:r is not recognized as a variable relative file. The return
code is set to 1.

n Specify a variable relative file.

***Error on input file - file is not a variable sequential file
n The file specified by /o:s was not recognized as a variable sequential file. The
return code is set to 1.

n Specify a variable sequential file.

***Error on input file - File locked
n The file you specified as your input file is locked by another process.

n Try again when the file is free to be accessed.

***Error on input file - file must be indexed for rebuild
n You have chosen to rebuild the index of an indexed file that is in the format used
by this COBOL system. The file is in the correct format but it is not an indexed
file. The return code is set to 1.

n Check that you have the correct file and have selected the correct action.

***Error on input file - file must be indexed for reorganization
n The input file is not an indexed file in the format used by this system. The return
code is set to 1.

n Check that you have the correct file, and that youmean to do a reorganization.

***Error on input file - file not found
n The input file cannot be found. The return code is set to 1.

n Check that the file-name you entered is correct, and the file does actually exist.
For reorganization or index rebuild ensure that the index file (.IDX) exists for
the given indexed data file.
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***Error on input file - illegal filename specified
n A file-name contains an illegal character. This could be any character that is not
part of the permitted character set or it could be the system-dependent delimiter,
which on most systems is the space.

n Try the file operation again using the correct file-name.

***Error on input file - invalid /x: key-of- reference
n The number specified in the key-of-reference option (/x) exceeds the number
of keys for the given file. The return code is set to 1.

n Check the key required, and try again.

***Error on input file - no record size information
n You have specified the /r option without specifying record lengths.

n Make sure that you specify record lengths when you specify the /r option. See
the section The /r Option earlier in this chapter for details.

***Error on input file - not MF indexed or variable format
n The input file is not an indexed file, or a variable format file in the format used
by this system. The return code is set to 1.

n Make sure that the file you specify is either an indexed file, or a variable file
whose format is recognized by this COBOL system.

***Error on input file - record size specified
n The record sizes specified in the /r option do not match those in the file.

n Correct the /r option and try the operation again.

***Error on input file - status xx ***Error on input file - status 9/yyy
n An error, other than one of the above input file errors, has occurred while
processing the input file. Possible causes are:

a) the file does not exist

b) a hardware error has occurred opening or reading the file

c) the file is corrupt

The status xx is an ANSI'85 file status. If the first byte is a 9, then the status yyy is a
COBOL run-time error number. The output file is closed, and should be usable, if not
complete. The return code is set to 1.

n See the Error Messages for more details of run-time errors.

***Error on output file - record length min or max
n The record length of the output file is less than the minimum or greater than the
maximum length you specified.

n Change the record lengths specified in the /r option.

***Error on output file - status xx ***Error on output file - status 9/yyy
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n Anerror has occurred processing the output file. Possible causes are that the file
cannot be created, or a hardware error has been encountered on opening or
writing the file, or the parameters specified are incorrect.

The status xx is an ANSI'85 file status. If the first byte is a 9, then the status yyy is a
COBOL run time error number. The return code is set to 2.

n See the Error Messages for more details of run time errors.

Information Messages

The following information messages are output when Rebuild is processing a file:
Converting file

n The file you specified is being converted from one format to another.

Rebuild aborted
n You will receive this error followed by one of the errors given in the section
Command Line Errors.

Rebuild successful
n The file you specified has been successfully rebuilt.

Rebuilding file
n The file you specified is being rebuilt.

Rebuilding index
n The index of the file you specified is being rebuilt.

Records processed
n The indicated number of records were processed when the file was converted,
rebuilt or reorganized.

Reorganization successful
n The file you specified has been successfully reorganized.

Reorganizing file
n The file you specified is being reorganized.

Warning Messages

Depending on the operation selected, some command line options are unnecessary. In
these cases, the incorrect usage will be indicated, but the option will be ignored and
processing will continue.

F Note that the option may be correct, but omission of other information may have
caused Rebuild to select the wrong process. If this is the case, correct the command
line and rerun.

** WARNING ** - Option ignored - /k option not needed for a reorganization
n A key definition option has been used when an indexed file reorganization
operation has been requested. The option is ignored.
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*** WARNING *** - Option ignored - /k option not needed with /n
n A key definition option has been used when an indexed file reorganization
operation has been requested. The option is ignored.

*** WARNING ***. Option ignored - /k option not needed for ms2 conversion.
n A key definition option has been used when you have requested a Microsoft
COBOLV2.2 conversion. This is not required since the key information is held
in the data file of a Microsoft V2.2 indexed file.

*** WARNING *** - Option ignored - /r option not needed for a reorganization
n A record structure for a reorganization has been used when only the /n
(information only) option was specified.

*** WARNING *** - Option ignored - /x option not needed for index rebuild
n A key of reference option has been used when an action other than indexed file
reorganization has been selected. The option is ignored.

*** WARNING ***. Option ignored - /x option not needed for ms2 conversion.
n A key of reference option has been used when you have requested a Microsoft
COBOLV2.2 conversion. This is not required since the key information is held
in the data file of a Microsoft V2.2 indexed file.

Micro Focus is a registered trademark ofMicro Focus Limited. Micro FocusCOBOL,
Fileshare, LEVEL II COBOL, and OSX are trademarks of Micro Focus Limited.
C-ISAM is a trademark of Informix Software Incorporated. OS/2 is a registered
trademark of International Business Machines Corporation. Microsoft and XENIX
are registered trademarks of Microsoft Corporation. Windows is a trademark of
Microsoft Corporation. Btrieve is a registered trademark of Novell, Incorporated.
UNIX is a registered trademark of UNIX Systems Laboratories, Inc.
@(#)Vrn/rebuild.doc/3.2.04/17Aug94/nrV Copyright (C) 1993-94 Micro Focus
Limited
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